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Important Information About Your Tape Drive 

Please take a minute to fill in the spaces on this page with information 
about your tape drive. The information requested will help ensure 
that you receive quick and thorough responses to your technical 
support, repair, and service needs. This information is also necessary 
to verify your warranty. 

Purchase Date: 

Drive Model Number: 

Product ID Number: 

Drive Serial Number: 
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Read This Page First! 

What You Should Do First 

Before you read this manual, follow these steps: 

1. Record important information about your tape drive. Fill 
in the spaces on the inside front cover of this manual with the 
information requested. This way, you'll have the information 
handy in case you ever need it. 

2. Install your tape drive. If your computer dealer installed your 
tape drive for you, skip this step. Otherwise, follow the instruc­
tions you received with your tape drive or installation kit. 

3. Install your EzTape software. Refer to the EzTape Getting 
Started Manual for instructions. 

When you complete these steps, you are ready to install EzTape®. 

About This Manual 

This manual shows you how to use the features of your EzTape 
software. We have designed this manual so that you can read it from 
cover to cover or just reference the information you need. 

For More Information 

For more information on how to quickly install and use EzTape, refer 
to the EzTape Getting Started Manual. Also, refer to the "Read 
Me" file that is installed with EzTape. 

If you have a problem using EzTape and cannot find a solution in the 
documentation, call or fax our Technical Support Hotline. The num­
bers to call are listed on the following page. 
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Contacting Technical Support in the U.S. and Canada: 

Telephone: (800) 2276296 

Fax: (407) 263 3536 

BBS: (407) 263 3502 

Hours are 8:30 AM to 8:00 PM EST, Monday through Friday. 

In Europe: 

Telephone: (44) 494 473434 

Fax: (44) 494 472044 

BBS: (44) 494 436302 

Hours are 9:00 AM to 6:00 PM U.K. time, Monday through Friday. 



Table of Contents 

Chapter: Title: Page: 

1 An Introduction to EzTape 1 

What This Chapter Contains 1 
EzTape's Backup and Restore Features 1 
Additional Features of EzTape 2 

About Data Compression 2 
The EzTape Librarian 3 
Network Support 3 

Developing a Backup Plan 3 
Tips for Easier Backups and Restores 4 

How You Can Use EzTape to Back up and 
Restore Files 4 

2 Exploring the EzTape Menu System 5 

What This Chapter Contains 5 
A Word About Operating Systems 5 

U sing the Screen Examples 5 
Graphics and Text Modes under DOS 6 

Starting EzTape 7 
Starting EzTape for DOS 7 
Starting EzTape for Windows 7 

A Look at the EzTape Window 8 
Title Bar 8 
Menu Bar 8 
Command Ribbon 8 
Status Bar 9 
Control Menu Icon 9 
Minimize and Maximize Icons 10 
Window Border 10 
Scroll Bars 10 

User's Manual Pagei 



Table of Contents Ez Tap e 

Chapter: Title: Page: 

2 Exploring the EzTape Menu System (continued) 

Choosing Commands from the Menus 10 
Selecting a Menu 10 
Choosing a Menu Option 11 
Canceling a Menu 11 
Shortcut Keys 11 

Completing a Dialog Box 12 
Option Buttons 13 
Check Boxes 13 
Text Boxes 13 
List Boxes 13 
Drop Down List Boxes 14 
Command Buttons . 14 

Selecting Files in the Directory Tree Window 14 
Opening a File Window 15 
Selecting Files and Directories 16 
Moving Among Open 'Windows 17 

Getting Help 18 
The Help Menu 18 
EzTape for Windows Help 19 
EzTape for DOS Help 19 

Cross-References 20 
Command Buttons 20 

Exiting EzTape 21 

3 The Quick Ways to Back Up and Restore 23 

What This Chapter Contains 23 
What are the Short-Cuts Options? 23 
Using the Quick Commands in the Short-Cuts Menu 24 

Backing Up All Files and Backing Up 
Modified Files 25 

Restoring All Files 26 

Page ii EzTape 



Ez Tap e 

User's Manual 

Chapter: Title: 

4 Backing Up Data From Disk 

5 

What This Chapter Contains 
Backing Up Files 

Backup Set Name 
Remarks 
Password 
Overwrite Backup Set 
Reset Archive Bits 
Verify After Backup 
Add to Library 
Compression 
Encryption 
U sing the Options Button 

The Wait for ... Options 
Batch Mode Only 
Scan Marked Files 
Set Unused Before Backup 
Logging Messages 

After You Make Backup Selections 

Restoring Data From Tape 

What This Chapter Contains 
Restoring Files 

Restore to 
Restore With Directory Structure 
File Overwrite 
Network Rights Restore 
Using the Options Button 

The Wait for ... Options 
Batch Mode Only 
Scan Marked Files 
Logging Messages 

After You Make Restore Selections 

Table of Contents 

Page: 

27 

27 
27 
28 
28 
29 
29 
29 
29 
30 
30 
30 
31 
31 
32 
33 
33 
34 
34 

35 

Using the Librarian to Restore Files from Tape 

35 
35 
36 
36 
37 
38 
38 
38 
39 
40 
40 
41 
41 

Page iii 



Table of Contents EzTape 

Chapter: Title: Page: 

Pageiv 

6 Marking and Manipulating Files 43 

7 

What This Chapter Contains 43 
When to Mark Files 43 
How to Mark Files 44 
Marking Files Manually 44 

U sing the Directory Tree Window to Make 
File Selections 44 

Selecting a Drive, Tape, or Library 
Directory Tree 45 

Opening a File Window 47 
Marking Files and Directories 47 

What the Mark Symbols Mean 47 
Excluding Files from Backup 48 
More About Marking 49 

Unmarking Files and Directories 49 
U nmarking All Files 49 
Obtaining Information About Marked Files 50 

Scanning Marked Files 50 
Listing Marked Files 51 

Using the File Management Commands 51 
Copying Marked Files 52 
Moving Marked Files 53 
Deleting Marked Files 54 
Changing the Attributes of Marked Files 55 

Using Mark Rules 

What This Chapter Contains 
What is a Mark Rule? 
U sing the Apply Rule Option 

Searching for Files 
Accessing and Using the Mark Rules Window 

Deleting a Rule 
Adding or Editing a Rule 

57 

57 
57 
58 
60 
60 
61 
61 

Ez Tap e 



EzTape Table of Contents 

Chapter: Title: Page: 

8 Creating and Using Parameter Files 63 

9 

What This Chapter Contains 
What is a Parameter File? 

63 
63 

How to Create a Parameter File 64 
Creating Parameter Files from the EzTape Menu 64 

How You Can Use Parameter Files 65 
Loading a Parameter File in the 

EzTape Window 
Running a Parameter File from the 

Command Line 
EzTape for DOS Users 
EzTape for Windows Users 

Adding a Parameter File as a Program Item 
(Windows Users Only) 

Using the EzStart Program 

65 

66 
66 
67 

67 

69 

What This Chapter Contains 69 
What is EzStart? 69 

What Happens When an Operation Begins 69 
EzStart for DOS 69 
EzStart for Windows 69 

Installation Notes 70 
EzStart for DOS 70 
EzStart for Windows 70 

Scheduling Events in the EzStart Window 71 
Opening the EzStart Window - DOS 71 
Opening the EzStart Window - Windows 71 
AddinglEditing an EzStart Event 72 

Command 73 
Dispatch Time and Date 73 
Recurring Event 73 
Announce Event 74 

Deleting an EzStart Event 74 
Placing an EzStart Event on Hold 74 

EzStart's Options Menu 75 
Creating a User Defined Interval 75 
Setting A Sticky Announcement (Windows only) 76 

If You Missed a Scheduled Event 76 

User's Manual Page v 



Table of Contents EzTape 

Chapter: Title: Page: 

Page vi 

10 Using the EzTape Tape Librarian 77 

11 

What This Chapter Contains 77 
What is the Librarian? 77 
Viewing the Contents of the Library 77 
Setting EzTape to Automatically Update 

the Librarian 78 
Label Your Tapes 79 
U sing the Librarian to Search for and Restore Files 80 

Searching the Library 80 
Restoring Files from Tape with the Librarian 80 

The Librarian Menu 81 
Updating the Library 81 
Backup Sets 81 

Displaying Information About a Backup Set 82 
Deleting a Backup Set from the Library 84 

Removing a Tape from the Library 84 

Using the Tape Utilities 

What This Chapter Contains 
The Utilities Menu 

Display Tape Info 
Name Tape 
Set Tape to Unused 
Backup Sets 

Getting Information About a Backup Set 
Deleting Backup Sets 

Retension Tape 
Initializing a Tape 

Using Preformatted Tapes 
Reusing Tapes 
U sing the Initialization Option 

Ejecting a Tape 

85 

85 
85 
85 
86 
87 
87 
88 
89 
89 
89 
89 
90 
90 
90 

EzTape 



EzTape Table of Contents 

Chapter: Title: Page: 

12 Manipulating Windows 91 

What This Chapter Contains 91 
Determining the Order of Files in a File Window 91 
Stacking, Tiling, and Cascading Windows 92 
Arranging Window Icons 92 
Refreshing Your Window Display 92 
Closing All Directory Windows 93 
Automatically Replacing File Windows 93 
Opening/Closing Windows 93 

The Directory Tree Window 93 
The Mark Rules Window 93 

Hiding and Showing the Command Ribbon 94 
Hiding and Showing the Status Bar 94 
Using the Open Windows List 94 
Printing with EzTape 95 

Using the Printer Setup Window 96 

13 Setting the Default Options 97 

What This Chapter Contains 97 
Setting Window Defaults 97 
Setting Backup Defaults 100 
Setting Restore Defaults 100 
Setting Organize Defaults 101 

A Using EzTape on a Network 103 

B Troubleshooting 111 

Index 121 

User's Manual Page vii 



I aO/e Of contents EzTape 

Page viii EzTape 



An Introduction to EzTape 1 
What This Chapter Contains 

This chapter shows you how you can get the most from your EzTape® 
software. Read this chapter to get information on: 

• the features that EzTape provides 

• how to develop a backup plan 

• how you can use EzTape 

EzTape's Backup and Restore Features 

EzTape software is the program you use to operate your tape drive 
with your computer. EzTape allows you to: 

• back up data from your computer's hard disk(s) and network 
drives. You can select the specific files, directories, and disks that 
you want to back up. You can also choose to back up only data 
that has been created or modified since your last backup. 

• restore data from tape to disk. You can select the specific files 
and directories that you want to restore. 

• create and use parameter files, which are files that contain the 
information needed to run customized backups and restores. 

• use the EzStart® program to schedule automatic, unattended 
backups and restores, as well as other events which you deter­
mine. 

You can use EzTape's backup and restore features to: 

• guard against loss of data. By regularly backing up the data that 
resides on your computer's hard disk, you will be protected in case 
of hard disk failure. 
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Chapter 1 An Introduction to EzTape 

• archive data on tape for future use. This also frees up space on 
your hard disk. 

• back up data from one computer and restore it on another com­
puter. Using tape is a convenient way to transport data between 
computers. 

Additional Features of EzTape 

Here are some additional features which EzTape provides for you: 

• command ribbon allows you to execute common commands by 
using simple buttons, rather than using menu commands 

• quick backup or restore by using the Short-Cuts menu 

• data compression to increase the amount of data you can store 
on tape 

• the ability to back up and restore data from multiple hard disk 
drives in a single operation 

• a Librarian option, which allows you to store the directory 
information from your EzTape backup tapes onto your hard disk. 
You can use this information to locate specific files on your tapes. 

• network support for most popular networks 

About Data Compression 

Page 2 

Data compression reduces file size during backup so you can store 
more data on tape. When you restore compressed files, they are 
automatically decompressed to return to their original sizes. 

EzTape offers three levels of data compression so that you can choose 
the best combination of system performance and compression ratio. 
The different levels are described in chapter 4, Backing Up Data 
From Disk. 
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The EzTape Librarian 

EzTape includes an integrated Librarian feature, allowing you to use 
your hard disk to store and manage directory information from tapes 
that you use with EzTape. Refer to chapter 10 for instructions on how 
to use the Librarian. 

Network Support 

EzTape also provides network support for most popular networks. 
Refer to appendix A for information on how to use EzTape to provide 
network backup. 

Developing a Backup Plan 

User's Manual 

In order to more fully protect your system from permanent loss of data, 
you should develop a backup plan and use it to make regular 
backups. For example, you can develop your backup plan based on 
how often you use your computer system and which files you update 
most frequently. 

A simple, effective backup plan might involve these steps: 

1. Once a week, make a backup of your entire hard disk. 

2. Each subsequent day in the week, back up those files you have 
modified or created. 

3. Begin the next week's backup on a new tape. You may want to 
archive the previous week's backup permanently, or just save it for 
a few weeks. 

If you plan on reusing tapes, we suggest that you use a tape rotation 
scheme. For example, you might: 

• place week l's backups on tape 1 
• place week 2's backups on tape 2 
• place week 3's backups on tape 3 
• reuse tape 1 and place week 4's backups on tape 1 
• reuse tape 2 and place week 5's backups on tape 2 

and so on. 
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Tips for Easier Backups and Restores 

To make backing up, restoring, and archiving data easier, we suggest 
that you do the following: 

• Keep extra tapes available during backup in case the size of a 
particular backup is larger than a single tape's available capacity. 

• Label each tape with the date, the tape's contents, and the tape ID 
number shown on the Display tape info screen. 

How You Can Use EzTape to Back Up and Restore Files 

Because it is so full-featured, there are a number of different ways you 
can use EzTape to back up and restore files: 

To perform: 

quick, simple backup and restore 
functions 

specialized backup and restore 
functions 

backup and restore functions from 
selections you have saved 

automated program initiation, 
including backup and restore, 
even when you are away from 
your computer 
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You can use: 

the Short-Cuts menu 

EzTape's powerful 
windowing system 

parameter files 

the EzStart program 

Refer to: 

chapter 3 

chapters 4 and 5 

chapter 8 

chapter 9 
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Exploring the EzTape Menu System 2 
What This Chapter Contains 

This chapter provides: 

• guidelines for using this manual with your operating system 

• instructions for starting and exiting EzTape 

• a brief description of the EzTape main window 

• instructions for using menu commands, dialog boxes, and the 
directory tree and file windows 

• guidelines for using EzTape help 

A Word About Operating Systems 

EzTape is available for several different operating system environ­
ments. This manual describes EzTape features that are common to 
the DOS and Windows environments. For specific instructions on 
setting up EzTape for use with your operating system, refer to the 
Getting Started manual. 

Using the Screen Examples 

User's Manual 

Throughout this manual you will find screens examples that are used 
to illustrate EzTape's features. Most of these screens are taken from 
EzTape for Windows. If you have EzTape for DOS, you will notice a 
slight difference in the appearance of your screens, but the features are 
identical. 
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The figure below shows a sample EzTape screen in both environments: 

EzTape for DOS 

EzTape for Windows 

Apply Rule 

Mask I ~~ ____________________________________ ~ 
[8J Include subdirectories 

Action 

@Mark 

o !!nMark 

D Mogified only 
Attributes 

[8J Bead only 
[8J ~ystem 
[8J Hidden 

Date/Time--------. 

@AlI 
o Before 
o .Qn 

o After 

Graphics and Text Modes under DOS 
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The EzTape for DOS screen shown above is displayed in graphics 
mode. This mode, available if you have an EGA or VGA monitor, uses 
special characters to give the screen a more attractive appearance. 

If you have a eGA or monochrome monitor, your screen will appear in 
text mode, using text characters to draw the screen display. 

You may change the display mode by selecting an option in the 
Window defaults dialog box, as described in chapter 13. 
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Starting EzTape 

To start EzTape, use the appropriate procedure for your operating 
system as outlined below. 

Starting EzTape for DOS 

1. Go to the DOS prompt and type: 

EZTAPE 

If EzTape is not in your system's path statement, do this from the 
EzTape directory. 

2. You will see the EzTape startup screen. Select the OK button, 
and you will be in EzTape. 

Starting EzTape for Windows 

1. Start Windows. 

2. Double click the EzTape icon from the Program Manager. 

~ Note: If you did not choose to add EzTape to a group 
during installation, you will need to use the Program 
Manager's Run command to start EzTape. See your 
Windows documentation for details. 

3. You will see the EzTape startup screen. Select the OK button, 
and you will be in EzTape. 
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A Look at the EzTape Window 

Control 
Menu 
Icon 

Status 
Bar 

Title Bar 

Menu Bar 

The figure below shows the parts of the EzTape software main window: 

Title Bar 

Name 
e:JAIM 
e:JBRIEF 
E:lCLlP 
E:lCOMDEX 
e:JDEB 
E:lDOS 
E!::lDUALBOOT 
e:JEJG 
e:JEPS 
E:lEZTAPE 
E!::lEZTAPEPM 
e:JGAMES 
L:lMAPCONS 

Size Modify date 
05/05/92 15:55 
05/02/91 12:06 
08/08/91 23:50 
05/20/92 13:47 
02112192 14:10 
04/22/91 . 10:56 
05/09/91 16:36 
05/20/92 13:16 
07112/91 12:46 
11/27/91 13:30 
06/27/91 15:53 
08/06/91 10:23 
0811 0/91 13:51 

Minimize/ 
Maximize 
Icons 

Window 
Border 

This bar displays the title EzTape and the version number at the top 
of the window. You can move the EzTape window by grabbing the title 
bar with your mouse. 

The menu bar is the part of the window that contains the names of the 
pull-down menus you can use. 

Command Ribbon 
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The command ribbon provides a means for you to perform commonly­
used operations with simple pushbuttons. You must have a mouse to 
select commands from the ribbon. 
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Status Bar 

The status bar provides a readout which displays the current status of 
your tape operation. 

Control Menu Icon 

User's Manual 

When you click on this icon (or press the [Al t] and [Spac ebar] keys 
simultaneously), you see the Control Menu. Every EzTape window 
has a Control Menu. It contains the following commands for manipu­
lating the window: 

Command: 

Restore 

Move 

Size 

Minimize 

Maximize 

Close 

Switch To 

Next 

Split 

What it does: 

Restores the window to its former size after it has 
been maximized or minimized. 

Allows you to use the keyboard to move the 
window to another location on the desktop. 

Allows you to use the keyboard to change the size 
of the window. 

Shrinks the window to an icon. 

Enlarges the window to its full size. 

Closes the window. 

(Windows environment only) Brings up the 
Windows task list. 

(Directory Tree and File windows only) Switches to 
the next open window. 

(File windows only) Allows you to use the 
keyboard to move a window's split bar. 
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Minimize and Maximize Buttons 

You can click on these buttons with your mouse to: 

• minimize the window to an icon, or 

• maximize the window to fill the screen 

Window Border 

Scroll Bars 

You can use the window border to resize the window by clicking and 
holding on it with your left mouse button, then dragging the border to 
the place you want it to be. 

The scroll bar allows you to see text that doesn't fit in the window. If 
you have a mouse, you can drag the scroll box to the part of the win­
dow you wish to see. Or, click the scroll arrows to move up and down 
in the window one line at a time. 

If you are using the keyboard, press the up or down arrow key that 
points in the direction you want to go. You can also use the [PgUp] 

and [PgDn] keys to scroll up and down one page at a time. 

Choosing Commands from the Menus 

EzTape's pull-down menus contain commands that are grouped accord­
ing to function. For example, the Tree menu contains commands for 
displaying the directory tree. 

Selecting a Menu 

To select a menu, you can either: 

• Click on the name of the menu you wish to see. 

• Press [Al t] or [FlO] to access the menu bar. Type the under­
lined letter in the name of the menu you want, or use the right 
and left arrows to select the menu name, then press [Enter]. 
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Choosing a Menu Option 

To choose an option in the menu, you can either: 

• Click the option you want in the menu. 

• Type the underlined letter in the name of the option you want, or 
use the up and down arrow keys to select the option, then press 
[Enter] . 

Some menu options contain features that tell you more about the 
option: 

Feature: 

Grayed out 

Ellipsis 

Check mark 

What it means: 

The option is not available at this time. 

Selecting this option calls up a dialog box where 
you will be asked to enter more information. 

The option is in effect. Check marks are used to 
toggle between menu options. 

Canceling a Menu 

Shortcut Keys 

User's Manual 

You can close the menu at any time by pressing [Esc] or by clicking 
anywhere outside the menu. 

Many EzTape menu options have key combinations assigned to them. 
These are called shortcut keys because they allow you to select a 
command without entering the menu. If a menu option has a shortcut 
key, you will see it displayed to the right of the option on the pull-down 
menu. 
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The figure below shows an example of shortcut keys assigned to the 
options in the Tree menu: 

Library 
Iape 

Ctrl+L 
Ctrl+T 

E~pand one level + 
Expand .l!ranch * 
!;.olJapse branch 

Completing a Dialog Box 

Command 
buttons 
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EzTape displays a dialog box when it needs more information to carry 
out a command. You select options or type in text to complete the 
missing information. The figure below shows a typical dialog box: 

Backup set name 

Remarks 

Overwrite backup set 

Password 

Backup set parameters for drive C 

I Drive C 

This is a backup of my entire disk drive. 

[8J Reset archive bits 

D Verify after backup 

[8J Add to library 

Compression 
@None 

o Levell 

o Level 2 

D Encryption 

Check boxes Option buttons 

] Textboxes 

Drop down 
list box 

If you are using a mouse, simply click the boxes to select the options 
you want. 

If you are using the keyboard, press [Tab] to move forward from one 
group of options to the next. To move backwards, press [Shi ft] 
[Tab]. Within a group of options, use the arrow keys to move through 
the list. 
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Option Buttons 

Check Boxes 

Text Boxes 

List Boxes 

User's Manual 

EzTape uses the following conventions to indicate when an option is 
selected: 

• In EzTape for Windows, the dotted rectangle box, called the 
selection cursor, marks the selected option. 

• In EzTape for DOS, the highlight bar marks the selected option. 

The following sections describe the items you will find in a dialog box. 

Use these buttons to select an option from a group. First, tab to the 
group, then use the up and down arrow keys to select the option you 
want and press [Enter]. If you are using a mouse, just click the 
option you want. Note that you can only select one option from the 
group. 

Use these boxes to turn options on and off. An option is selected ifit 
contains an X. You can check more than one box in a group. To select 
a check box, tab to the group, cursor to the item you want, then press 
the [Spacebar] key to enter an X. Press [Spacebar] again to clear 
the selection. If you are using a mouse, click on the check box to enter 
an X; click again to clear the selection. 

Use these boxes to enter text, such as a file name. To enter informa­
tion in a text box, tab to the box and start typing at the text insertion 
point. (You can use the arrow keys to change the position of the 
insertion point.) Or, you can click on the text already in the box and 
start editing. 

List boxes display a list of options to choose from. To select an option 
in a list box, tab to the box, use the up and down arrow keys to select 
the option you want, then press [Enter]. 
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Drop Down List Boxes 

Some text boxes may contain a drop down list box. In these cases, a 
default response is displayed in the text box, but you can see additional 
responses by accessing the drop down list. Press [F 4] or click the 
arrow to the right of the box to view these options. You select an 
option from the drop down list just as you would with a list box. 

Command Buttons 

Command buttons initiate an action. Most dialog boxes contain at 
least two command buttons: Cancel and OK. Select Cancel to 
abandon the dialog box and the menu option that prompted it. Select 
OK to accept the responses in the dialog box and proceed. 

Sometimes you will see a command button that contains an ellipsis. 
For example, Options ... The ellipsis means that choosing this com­
mand button will bring up another dialog box. 

To choose a command button, tab to it and press [Enter], or simply 
click it. 

Selecting Files in the Directory Tree Window 
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From the main window, you can access two other types of windows: 
the Directory Tree and File windows. These are the windows where 
you select files for backup or restore. 

The directory tree shows the directories of the current drive or backup 
set. You will learn how to change the directory display in chapter 6. 

A file window appears when you open a directory in the directory tree. 
This window lists the subdirectories and files in that directory. 
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Selection cursor 

The figure below shows both of these windows: 

Directory Tree Window 

COMDEX 
DEB 
DOS 
DUALBOOT 
EJG 
EZTAPE 
EZTAPEPM 
GAMES 

File Window 

Name 
L:l .. 
r.::lCLlP.EXE 
Cl CLlPLlB.DLL 
Cl COMPLETE.EPS 
Cl CONFIG.EPS 
Cl GROUP.EPS 
Cl HARDWARE.EPS 
Cl INSTALL.EPS 
Cl REGISTEREPS 
Cl SAMPLE.BMP 
Cl SAMPLE.MSP 
Cl SAMPLE.PCX 
Cl STARTUP.EPS 

EzTape uses a selection cursor to indicate the currently selected file or 
directory in these windows: 

• 

• 

In EzTape for Windows, a dotted rectangle box marks the current 
item. 

In EzTape for DOS, a caret ( ~) appears next to the current item . 

Opening A File Window 

To open a file window for a directory: 

• Double-click on the directory. 

or 

• Use the up and down arrow keys to position the cursor over the 
directory you want to open, then press [Enter]. 
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Selecting Files and Directories 
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You select files by highlighting them with your mouse or keyboard 
commands. 

To select files or directories with a mouse: 

• Click the item you wish to select. 

• To select multiple items, hold down the mouse button and drag the 
highlight bar over the items you wish to select. 

To select files or directories with the keyboard: 

• Use the up and down arrow keys to position the cursor at the item 
you wish to select. 

• To select multiple items, hold down the [Shift] key, then use the 
up or down arrow keys to highlight the range you wish to select. 

~ Note: In EzTape for Windows versions 3.1 or earlier, 
the selection cursor moves independent of the highlight bar. 
To select files or directories with the keyboard, you must first 
move the selection cursor over the item you want, then press 
[Spacebar] . 

EzTape offers the following additional keyboard commands to make 
file selection easier: 

To: 

Scroll the selection cursor up one page 

Scroll the selection cursor down one page 

Move the selection cursor to the first item in the 
window 

Press: 

[PgUp] 

[PgDn] 

[Home] 

Move the selection cursor to the last item in the [End] 
window 

Select the current item plus all items in the page 
above it 

[Shift] [PgUp] 
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To: 

Select the current item plus all items in the page 
below it 

Select the current item plus all items above it 

Select the current item plus all items below it 

Make non contiguous selections (select items 
that aren't in a range) 

Select all items in the window 

Cancel the current selection 

Cancel all selections 

Press: 

[Shift] [PgOn] 

[Shift] [Home] 

[Shift] [End] 

[Ctrl] + key­
strokes 

[Ctrl] [I] 

[Ctrl] [Spacebar] 

[Ctrl] [\] 

Moving Among Open Windows 

User's Manual 

While you may have many windows open, you may only work in one 
window at a time. The currently selected window is called the active 
window. It usually appears at the front of the desktop, and its title bar 
has a different color to distinguish it from the other open windows. 

The easiest way to make a window active is to click anywhere in the 
window with a mouse. 

If you are using a keyboard, follow these steps to make a window 
active: 

1. Press [Alt] [Spacebar] to open the control menu of the current 
active window. 

2. Type [T] to choose the Next command. 

3. Repeat these steps until you're at window you want. 

You may type [Ctrl] [F6] as a shortcut for steps 1 and 2. 
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Getting Help 

The Help Menu 

Exploring the EzTape Menu System 

Another way to make a window active is to select it from the list at 
bottom of EzTape's Window menu. 

You can return to the Directory Tree window from an active window 
by pressing [Esc]. Exception: This feature was not implemented in 
EzTape for Windows versions 3.1 or earlier. 

You can access EzTape's on-line help at any time while you are in the 
EzTape program. Use one of the following methods to access the help 
screens in EzTape: 

• Press [FI] to get context sensitive help for any menu or menu 
option you highlight or for any active dialog box. 

• Use the Help menu to get information about a specific topic. 

EzTape's Help menu contains the following options for obtaining 
information about EzTape: 

Use this option: To obtain: 

Index an index of help topics 

Keyboard a description of every keyboard command that can 
be used with EzTape 

Commands help for EzTape menu commands 

Procedures help for specific EzTape topics 

Using Help help for using the help options 

About... the EzTape startup information screen 
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EzTape for Windows Help 

EzTape for Windows follows standard Windows conventions for on-line 
help. If you need more information about using help, you can: 

• Select Using Help from the Help menu. 

• Consult your Windows documentation. 

EzTape for DOS Help 

Definitions 

Related Topics 

This section describes on-line help specifically for EzTape for DOS. 

Whenever you access help, whether by selecting an option from the 
Help menu or pressing [F 1] , you will receive a screen similar to the 
one below: 

18-~~~~EI~IB~~~IIElII~;a~;m'IlIlIl"lIlIlIlIlIlIlIlIlIlt 
Restorin!l Tapes frol11 the Librarll 

3. Click the Restore button in the ribbon. 
Or select Start restore frol11 the Tasks l11enu. 

1. When the Restore paral11eters dialo!l box appears, select the options lIOU 

want, then select OIL 

Ez Ta pe will prol11pt lIOU to insert the tapes needed to COI11P I ete the restore. 

HI': ltt!ed ... ~9Pjc~ 
Select hilt d !1ediii'typi:i 
a Se lect ions .... gTe'm ~ ~RCEFj ~ ~ 

Command button 

User's Manual 

The following subsections describe the features of the EzTape for DOS 
help screen. 
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Cross-References 

Cross-references are words or phrases that allow you to "jump" to a 
another help topic. A cross-reference is indicated by highlighted text. 

To jump to a cross-referenced topic, you can either: 

• Double click the cross-referenced text. 

• Press [Tab] until you have selected the cross-reference you want, 
then press [Enter]. Press [Shift] [Tab] to move backwards 
on the screen. 

In general, there are two types of cross-references that appear in 
EzTape for DOS help: definitions and related topics. 

When a word or phrase in the help topic appears highlighted, that 
means it has a definition associated with it. Use your mouse or 
keyboard to jump to a brief definition of the word or phrase. To return 
to your original topic, select the Back command button, described in 
the next subsection. 

The related topics listed at the end of the topic are a convenient way 
for you to jump to other topics that are related to the one you just 
viewed. 

Command Buttons 

EzTape help contains the following command buttons to assist you in 
finding the help topics you need: 

Command button: What it does: 

Index Displays an index of all EzTape help topics. 

Next Displays the next topic in a sequence. Use 
this button to browse through related topics. 

Previous Displays the previous topic in a sequence. Use 
this button to browse through related topics. 

Back Displays the last topic you viewed. 
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Command button: What it does: 

Search Lists keywords for the help topics. When you 
select a keyword, you will see a list of topics 
that contain that keyword. You can then select 
a topic to display from the list. 

Print Prints the current help screen. (Make sure that 
your printer is turned on before choosing this 
command.) 

Exit Closes the Help window and returns you to 
EzTape. 

To select a command button, press the [Al t] key plus the underlined 
letter in the command you wish to use. Or, you can just click the 
command button. 

Exiting EzTape 

User's Manual 

There are two ways that you can exit EzTape: 

• Select Exit from the File menu. 

• Select Close from the EzTape Control Menu. 

When you choose these commands, you will end your EzTape session 
and return to the system. 
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What This Chapter Contains 

This chapter provides a description of the Short-Cuts options which 
you can use to perform quick backups and restores. 

~ Note: Before you begin, insert the tape cartridge that you 
are restoring from or backing up to. 

What are the Short-Cuts Options? 

The Short-Cuts command provides the following quick command 
options: 

• back up all files on a particular disk drive 

• back up only the files on a disk drive that have been added or 
modified since last backup 

• restore all backup sets from a tape 

User's Manual Page 23 



Chapter 3 The Quick Ways to Backup and Restore 

Using the Quick Commands in the Short-Cuts Menu 
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To access the Short-Cuts menu, use the following procedure: 

1. Enter EzTape using the guidelines in chapter 2. 

2. Choose the Short-Cuts option from the File menu. You will see 
the Short-Cuts menu: 

I Short-Cuts 

The Short-Cuts menu has the three quick command buttons. When 
you want to exit the menu, you can choose the Main Menu button to 
return to the EzTape main menu or the Exit Program button to exit 
out of the EzTape software. 
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Backing Up All Files and Backing Up Modified Files 

User's Manual 

The Backup All Files on Disk option will make a complete backup of 
each of the drives that you select. The Backup Modified Files on 
Disk option will back up only those files which have been added or 
changed since last backup. The files for each drive you back up will be 
stored on the tape in a group called a backup set. A backup set is the 
group of files stored on the tape during a single backup session. 

When you select one of these options, you receive the following window: 

II Disk Drives 

r-,
select drivels] to backup: .. 

F: . 
G: . 
M: 
~ 

I: ... QKI D~';'~'c~)j] 

When you are through selecting the drive(s) to back up, select the OK 
option. The backup will begin. 

If you run out of room on your tape during the backup operation, 
EzTape will prompt you to continue the backup on a second tape. 
Insert tapes as needed until the backup is complete. 
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Restoring All Files 
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The Restore Current Tape option restores everything from the tape 
in the backup drive, except hidden and system files. If your tape 
contains backup sets from more than one drive, this option will restore 
the files to the drives from which they came, in the order in which you 
created them. 

The Restore Current Tape option restores multiple-tape backups; 
that is, if your backup spans two tapes, this option will prompt you for 
the second tape once it has restored the first tape. 

When you select this option, the restore will begin. 
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What This Chapter Contains 

This chapter shows you how to back up data from a hard disk drive to 
tape. 

Backing Up Files 

User's Manual 

~ Note: Insert the tape cartridge before you begin to back up 
data. 

To back up selected files from disk to tape, you must: 

1. Indicate that you will select files from disk for backup by either: 

• clicking the Disk button in the command ribbon 
• selecting Disk from under the Tree menu 

A list of the hard drives on your system appears in the Directory 
Tree window. If a directory icon has: 

• a "+" sign, it contains subdirectories. Click on the directory 
icon to display the list of subdirectories. 

• a "-" sign, it is currently displaying its subdirectories. Click 
on it again to hide the subdirectories. 

• no sign, it does not contain any subdirectories. 

2. Highlight the directories or files you want to back up. Then, use 
the Mark button in the command ribbon or the Mark selected 
files option in the Mark menu to mark the selected directories and 
files. A black circle appear next to each directory and file you 
selected. 
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For more detailed information on selecting and marking files, refer 
to chapter 6, Marking and Manipulating Files. 

3. Select the Backup button from the command ribbon or select the 
Start Backup option from the Tasks menu. You see the Backup 
set parameters window: 

Backup set name 

Remarks 

Overwrite backup set 

Password 

.-
Cancel 

OK 

Backup set parameters for drive C 

I Drive C 

This is a backup of my entire disk drive. 

10 
~========~I--------~ 

. Compression 
~~~~~~~,..,. @ None 
I! Options... ·····1 0 Levell 

rgJ Reset archive bits 0 Level 2 

D Verify after backup 
rgJ Add to library D Encryption 

If you selected files from multiple drives, you will receive this 
window for every drive selected. EzTape makes a separate backup 
set for each drive. 

The following sections show you how to use the options in the Backup 
set parameters window . You can set default values for some of these 
parameters. For more information on setting defaults, see chapter 13. 

Backup Set Name 

Remarks 
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This is the name of the backup set that will be stored on tape. Enter a 
name of up to 31 alphanumeric characters in length. If you create 
more than one backup set with the same name on a tape, EzTape will 
automatically append a sequential number to the name. 

You may optionally enter any comments you may have concerning the 
contents of this backup set for future reference. These remarks can be 
up to 127 characters long. You can read these comments from the 
Backup Set Info screen, as described in chapter 11. 
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Password 

You may optionally assign a password to the backup set if you want to 
prevent access to it by other users. You may choose a password of up 
to 15 alphanumeric characters. The password is case-sensitive, so the 
password topsecret is not the same as TOPSECRET. 

Overwrite Backup Set 

You can select a backup set from this list to overwrite. This will 
destroy the old backup set. This option is not available if you are 
using a streaming tape drive (such as the Irwin 7000 and 9000 Series 
drives and the Irwin model A850). 

Reset Archive Bits 

If you select this option, EzTape will back up all selected files, then 
check the archive bits for these files. If the archive bit for a file was 
on, it will turn the bit off. If the bit is in the off position, this lets the 
operating system and EzTape know that the file has been backed up. 
If you later change the file, the operating system will turn the archive 
bit back on. 

When you back up files using the Backup Modified Files on Disk 
option, EzTape will back up only those files with the archive bit on. 

Verify After Backup 

User's Manual 

If you select this option, EzTape will perform a byte-by-byte compari­
son between the backed-up tape data and the hard disk data once the 
backup is complete. This function is optional since EzTape ensures 
data integrity during backup with its patented EC/Tape error correc­
tion method. If you are using a streaming tape drive (such as the 
Irwin 7000 and 9000 Series drives and the Irwin model A850), this 
option will be grayed out because on such devices, read after write 
eliminates the need for a separate verify. 

- Performing a verify will approximately double the time required for 
the backup. 
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Add to Library 

Compression 

Encryption 
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Backing Up Data From Disk 

If you select this option, EzTape will automatically add this backup set 
to the Library when it is completed. For more information on the 
Librarian, refer to chapter 10. 

Select the level of data compression for the backup. If you choose to 
use data compression, your files will be reduced during backup so that 
they take up less room on the tape. When you restore the compressed 
files, they will automatically decompress to return to their original 
sizes. 

There are three levels of data compression: 

• Level 0 provides no data compression. 

• Levell provides data compression of approximately 1.2:1 (files 
compress to 80% of original size). 

• Level 2 provides data compression of approximately 2:1 (files 
compress to 50% of original size). 

For most systems, using Levell compression will result in an im­
proved backup time. You may want to experiment with your system to 
see how using Level 2 compression affects performance. In some cases, 
using Level 2 compression may result in longer backup times. In 
general, we recommend that you use Level 2 compression when you 
want to increase capacity, not as a way to improve backup time. 

Some files can be compressed more than others. For example, text and 
graphics files usually compress more than executable files. If EzTape 
encounters files that have been compressed by other application 
software, no further compression occurs. 

Select the encryption option if you want the backup set to be encoded 
until it is restored to its original form. This option is useful for secu­
rity purposes. 
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When you select the Encryption box, a window will appear asking for 
an encryption key of 6 to 16 characters. Enter the encryption key and 
select OK. Remember the encryption key; you will need it to 
restore your data. The key is case-sensitive. Without the key, there 
is no way to restore the data-even we will not be able to recover it. 

Using the Options Button 

User's Manual 

When you select the Options button in the backup window, you see 
the following window: 

Wait For-------, 
D r.F..tt~.·.·.~·h.~·.~·i.·~.·g.·.·.·~ .. ii·~.·i.~] 
[2J Critical errors 

D Non-critical errors 

Batch mode only: 

[2J Split backup set 

D Operation completed 

D Scan marked files 

D Set unused before backup 

Log 

[2J Log messages and ... 
D Excluded file list 

D Included file list 

Log file name: 

I BACKUP.LOG 

I OK 

These options apply to the entire backup session. This means that you 
may have only one set of backup options for all backup sets created. If 
you select different options for each backup set, EzTape will use the 
last set selected. 

The Wait for ... Options 

Use these options to specify when EzTape should pause during an 
operation to hold a message on the screen. For example, if you checked 
the Critical Errors box and a critical error occurs, EzTape will pause 
the current operation and display the appropriate error message on the 
screen. 
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The following table describes the wait options: 

This error type: 

File Sharing Errors 

Critical Errors 

Non-Critical Errors 

Includes errors: 

that occur when EzTape attempts to access 
files that are in use by another application 

that prevent the current backup or restore 
operation from completing 

from which EzTape can recover and continue 

You may select any combination of these choices. 

All error messages will appear in the Message Log after the operation 
completes, whether or not EzTape pauses to display them. For more 
information on error messages, refer to appendix B. 

Batch Mode Only 

The following options apply only when EzTape is operating in batch 
mode. EzTape operates in batch mode when you execute a parameter 
file. 

The following table describes the two batch mode options: 

This option: Tells EzTape: 

Split Backup Set to pause if it encounters a split backup set, 
allowing you to insert the additional tape. In 
most cases, you will want to set this option. If 
you don't, EzTape will stop after backing up to 
the first tape. 

Operation Completed to pause for confirmation once the operation is 
finished. If you do not choose this option, the 
default is to exit the program upon completion. 
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Scan Marked Files 

Choosing the Scan Marked Files option enables the following informa­
tion to be displayed during the backup: 

• a time line showing to show you the status of the backup 

• the total number of bytes and files you backing up 

• the percentage of the backup that is complete 

If you check this box, EzTape will automatically scan the marked files 
before the backup begins. You will see a window similar to one below: 

Scan Marked Files 

Drives: 
Dire do ri e s: 

Files: 

Total bytes: 

6 
133 

6.304.396 

Set Unused Before Backup 

The option allows you to re-use a tape. If selected, for an Irwin 
AccuTrak Series drive (except the A850), EzTape will set the tape to 
unused before the backup begins. For Irwin streaming tape drives 
(A850, 7000 Series, and 9000 Series), EzTape will erase the tape. 

Caution: Before using this option, make sure that the 
tape does not contain information that you want to 
save. 
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Logging Messages 

If you select the Log messages and ... box, messages in the error log 
will be saved and the following options are enabled. 

If you select the Excluded file list option, EzTape will append a list 
of files that were excluded from the backup set (due to sharing viola­
tions, etc.). If you select the Included file list option, EzTape will 
append a list of files that were included in the backup set. 

In the Log File Name field, enter a name for the log file. 

After You Make Backup Selections 

Page 34 

Once you make selections, click the OK button. You will see the 
Backup Status window: 

Backing up files 

Current operation: Copying files to tape ... 
Files completed: 152 Total files: 155 
Bytes completed: 3,686,934 Total bytes: 3.762,385 
Transfer rate: 2.4 meg/min Percent completed: 98% 
Elapsed time: 0:01 :56 Compression ratio: 1.6:1 

~I ~~~~~~~~ 
Current file: AIMRETEN.EXE 
Source: C:\AIM 
Destination: 1 :\Drive C-3 
Backup set will be called 'Drive C-3'. 
Copying files to tape ... 

Ez Tap e 



Restoring Data From Tape 5 
What This Chapter Contains 

This chapter shows you how to restore data from tape to a hard disk 
drive. 

Restoring Files 

User's Manual 

~ Note: Insert the tape cartridge that you are restoring from 
before you begin to restore data. 

To restore selected files from tape to disk, you must: 

1. Indicate that you will select files from tape for restore by either: 

• clicking the Tape button in the command ribbon 
• selecting Tape from under the Tree menu 

A list of the backup sets on your installed tape appears in the 
Directory Tree window. If a backup set or directory icon has: 

• a "+" sign, it contains subdirectories. Click on the directory 
icon to display the list of subdirectories. 

• a "-" sign, it is currently displaying its subdirectories. Click 
on it again to hide the subdirectories. 

• no sign, it does not contain any subdirectories. 

2. Highlight the directories or files you want to restore. Then, use 
the Mark button in the command ribbon or the Mark selected 
files option in the Mark menu to mark the selected directories and 
files. You will see a black circle appear next to each directory and 
file you selected. 
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Restore to 

Restoring Data From Tape 

For more detailed information on selecting and marking files, refer 
to chapter 6, Marking and Manipulating Files. 

3. Select the Restore button from the command ribbon or select the 
Start Restore option from the Tasks menu. You will see the 
Restore parameters window: 

Restore parameters for 'Drive G' " 

Restore to a..;;:ltim=-___________ --' 

[g] Restore with directory structure 

File Overwrite 

1;'< Options ... < < ,I 
@ Do not overwrite newer files 

o Prompt if newer file exists 

o Restore all selected files 

Network Rinhts Restore 
o Do not restore any rights 

@ Restore target directory rights only 

o Restore rights to all directories in target path 

If you selected files from more than one backup set, you will 
receive this window for each backup set selected. 

The following sections show you how to use the options in the Restore 
parameters window. You can set default values for some of these 
parameters. For more information on setting defaults, see chapter 13. 

This field must contain the directory path where you want the data 
restored. When the window opens, this field will contain the directory 
path for the original source drive of the backup set (for example, C: \). 
If you want to restore the data to another location, enter the new 
directory path in this field (for example, C: \ TEMP). 

Restore with Directory Structure 
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Select this option if you want the data to be restored in its original 
directory structure. If you don't select this option, all files will be 
stored at the same directory level. 
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File Overwrite 

User's Manual 

For example, let's say you are restoring a file named TEST in the 
REPORTS directory. You are restoring to the directory path C:\. If 
you choose this option, then TEST will be restored in the REPORTS 
directory. If you don't select this option, TEST will be restored directly 
into the root directory C:\. The figure below shows a graphic depiction 
of this example: 

With the Option Without the Option 

These options allow you to specify if you want EzTape to write over a 
newer hard disk file with an older file from the backup tape. Usually, 
you will want to retain the newer version of the file. Choose the 
appropriate option from the following table: 

If you: 

never want a newer file on your hard 
disk overwritten by a file from the tape 

want to be prompted for verification 
before EzTape overwrites a newer 
hard disk file 

want EzTape to write over newer 
files without informing you 

Select this option: 

Do not overwrite 
newer files 

Prompt if newer file 
exists 

Restore all selected 
files 
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Network Rights Restore 

If you are restoring Novell network files, the restore window provides 
three options for retaining trustee rights: 

• do not restore any rights 

• restore target directory rights only 

• restore rights to all directories in the target path 

For more information on using Novell network trustee rights, refer to 
appendixA. 

Using the Options Button 
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When you select the Options button in the restore window, you see 
the following window: 

, Restore Options. . 

Wait For-------, 

o tf.I.f~:·.·.~h.~·.d·~.·g.·.·.·~.·~i·~.'i.~'j 
[g] Critical errors 
o Non-critical errors 
Batch mode only: 

[g] Split backup set 
o Operation completed 

o Scan marked files 

Log 
[g] Log messages and ... 

o Excluded file list 
o Included file list 

Log file name: 

I RESTORE.LOG 

These options apply to the entire restore session. This means that you 
may have only one set of restore options for all backup sets restored. If 
you select different options for each backup set, EzTape will use the 
last set selected. 

The Wait for ... Options 

You use these options to specify when EzTape should pause during an 
operation to hold a message on the screen. For example, if you checked 
-tbe Critical Errors box and a critical error occurs, EzTape will pause 
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the current operation and display the appropriate error message on the 
screen. The following table describes the Wait options: 

This error type: 

File Sharing Errors 

Critical Errors 

Non-Critical Errors 

Includes errors: 

that occur when EzTape attempts to access 
files that are in use by another application 

that prevent the operation from completing 

from which EzTape can recover and continue 
operation 

You may select any combination of these choices. All error messages 
will appear in the Message Log after the operation completes, whether 
or not EzTape pauses to display them (you must have logging enabled). 
For more information on error messages, refer to the Appendix B. 

Batch Mode Only 

The following options apply only when EzTape is operating in batch 
mode. EzTape operates in batch mode when you execute a parameter 
file. 

The following table describes the two batch mode options. 

This option: Tells EzTape: 

Split Backup Set to pause if it encounters a split backup set, 
allowing you to insert the additional tape. In 
most cases, you will want to set this option. If 
you don't, EzTape will stop after restoring the 
first tape. 

Operation Completed to pause for confirmation once the operation is 
finished. If you do not choose this option, the 
default is to exit the program upon completion. 
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Restoring Data From Tape 

Scan Marked Files 

Choosing the Scan Marked Files option enables the following infor­
mation to be displayed during the restore: 

• a time line to show you the status of the restore 

• the total number of bytes and files you are restoring 

• the percentage of the restore that is complete 

If you check this box, EzTape will automatically scan the marked files 
before the restore begins. You will see a window similar to the one 
below: 

Scan Marked Files 

Drives: 

Directories: 

Files: 

Total bytes: 

Logging Messages 

1 

6 

133 
6.304.396 

If you select the Log messages and ... box, messages in the error log 
will be saved. This option also enables the other options in the Log 
box. 

If you select the Excluded file list option, a list of files that were not 
restored (due to sharing violations, etc.) will be appended to the log. 

If you select the Included file list option, a list of files that were 
restored will be appended to the log. 

In the Log File Name field, enter a name for the log file. 
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After You Make Restore Selections 

Once you have made selections, click the OK button. You will see the 
Restore Status window, which provides information on the status of 
the restore: 

Restoring files 

Current operation: 

Files completed: 
Bytes completed: 
Transfer rate: 
Elapsed time: 

1-

Copying files ... 

41 
1,903,628 
1.1 meg/min 
0:02:03 

Current file: TABLES.PUB 
Source: Drive G\TEX\PUB 
Destination: G:\TEX\PUB 

Total files: 377 
Total bytes: 15,614,819 
Percent completed: 12% 
CGmprc~;!;~ion Pltio: 1.0:1 

If you are restoring data that spans two or more tapes, EzTape will 
prompt you when it is time to insert a new tape. 

Using the Librarian to Restore Files from Tape 

User's Manual 

You can also restore files by marking them in the tape library. The 
library contains backup set information about the tapes you've used 
with EzTape. For more information about the Librarian feature, refer 
to chapter 10. 

The Librarian allows you to restore files and backup sets from multiple 
tapes. You can also use the Librarian to select files from a split 
backup set. Once you start the restore, EzTape will prompt you to 
insert the correct tapes as needed. 
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What This Chapter Contains 

This chapter provides the following information: 

• when you need to mark files 

• how to mark and unmark files using the Directory Tree window 

• how to obtain helpful information about your marked files 

• how to copy, move, delete, and change attributes for marked files 

When to Mark Files 

In EzTape, you designate files for a task, such as backup or restore, by 
marking them. For example, you will mark files when you want to 
specify: . 

• directories or files that you want to back up from your hard disk to 
tape 

• directories or files that you want to restore from tape to your hard 
disk 

• directories or files on your hard disk that you want to copy, move, 
change, or delete 

• files to search for on a hard disk, on a tape, or in the Librarian 
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How to Mark Files 

There are two ways to mark files: 

• manually, through the directory tree window 

• using the Apply Rule option as described in chapter 7 

Marking Files Manually 

Marking files manually involves two steps: highlighting your selec­
tions, then marking them. This method allows you to select a combi­
nation of drives, directories or individual files for an EzTape task. It's 
important to remember that highlighting a file is not the same as 
marking it. 

Using the Directory Tree Window to Make File Selections 

You use the Directory Tree window to highlight the drive, directory or 
individual files you wish to mark. The Directory Tree window is 
normally present when you start up EzTape. If you have closed the 
Directory Tree window and would like to open it again, select Show 
directory tree from under the Window menu. 

The following sections show you how to: 

• list the directories or backup sets for a hard disk, library, or 
backup tape 

• use the Directory Tree window to display and mark directories 
or backup sets 

• use a file window to display and mark the contents of a directory 
or backup set 
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Selecting a Drive, Tape, or Library Directory Tree 

Buttons in the 
command ribbon 

Before you can mark or unmark selections, you must first choose the 
media type that you want to select files from: a hard disk, the EzTape 
library, or the tape installed in your tape drive. (When you first start 
EzTape, the directory tree displays your hard disk volume.) 

To select a media type, you can either: 

• Click the Disk, Library, or Tape buttons in the command ribbon, 
shown below: 

file Tree Mark Iasks .utilities Yiew Qptions 

• Select Disk, Library, or Tape from under the Tree menu. 

Once you select a media type, the appropriate directory tree will 
appear in the Directory Tree window. If you selected: 

• Disk, you see a list of hard drives on your system 

• Library, you see a list of backup sets in your library 

• Tape, you see a list of backup sets on your installed tape 
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The figure below shows a directory tree displaying the contents of a 
hard drive: 

AIM 
BRIEF 
CLIP 
COMDEX 
DEB 
DOS 
DUALBOOT . 
EJG 
EPS 
EZTAPE 
EZTAPEPM 
GAMES 

If your directory or backup set has: 

• a "+" sign, it contains subdirectories. Click on the backup set or 
hard disk directory to display this list of subdirectories. 

• a "-" sign, it is currently displaying its subdirectories. Click on it 
again to hide the subdirectories 

• no sign, it does not contain any subdirectories 

You can also display or hide directory tree information by using the 
following choices from under the Tree menu: 

• Expand one level expands a directory to its first level of 
subdirectories 

• Expand branch expands a directory to show all levels of 
subdirectories 

• Collapse branch hides all levels of subdirectories in the selected 
directory 
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Opening a File Window 

When you open a directory, you see a file window for that directory. 
This window lists the subdirectories and files in that directory. 

BACKUP.BMP 
Cl BACKUP.ICO 
Cl DISK.BMP 
Cl FLDRMINS.BMP 
Cl FLDRPLUS.BMP 
Cl FOLDER.BMP 
Cl LlB.BMP 
Cl MARK.BMP 
Cl MARK.ICO 
Cl RESTORE.BMP 
Cl RESTORE.ICO 
Cl SCAN.BMP 

766 07/22/91 15:59 
766 06119191 16:23 
886 04/08/91 14:46 
274 04/09/91 13:24 
274 04/09/91 14:24 
274 03/26/91 17:08 
886 04/08/91 15:33 
766 07/22/91 15:58 
766 05/22/91 09:45 
766 07/22/91 16:00 
766 06119191 16:34 
766 07/22/91 16:01 

Marking Files and Directories 

User's Manual 

To mark files or directories, highlight the items you wish to mark with 
your mouse or keyboard. Then, use the Mark button in the command 
ribbon or the Mark selected files option in the Mark menu to mark 
the selected directories and files. A black circle will appear by the file 
or directory you selected. (In text mode, this mark appears as black 
rectangle. ) 

What the Mark Symbols Mean 

When you mark a directory, all subdirectories and files in that direc­
tory are also marked. If you mark a directory that does not contain 
any files, a black circle (or rectangle) still appears by that directory to 
indicate it was marked. This is useful when you are using parameter 
files (chapter 8). The mark indicates that the parameter file will back 
up any files that may one day appear in that directory. 
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Marking File Selections 

In the figure below, the backup set "Drive G" is marked, so all of its 
subdirectories are marked as well. 

When you mark a file or subdirectory within a directory, a half 
circle appears by the parent directory to show that part of its contents 
may be marked. (In text mode, this mark appears as a black dot.) If 
you mark a subdirectory that does not contain any files, a half circle 
(or dot) still appears by that directory to indicate that there is a mark 
rule which applies to it. 

If you want to make sure that a marked directory contains files, use 
the Scan marked files or List marked files options, described later 
in this chapter. 

Excluding Files from Backup 

You may notice that some files are marked with a circle with an X in 
the middle. (In text mode, this mark appears as a plain X.) These files 
are system files, or files currently in use, that EzTape has excluded 
from all backups. 

The names of excluded files are contained in the file EXCLUDE.CFG. 
If you want to add a file to this lists, you can edit EXCLUDE.CFG 
using a text editor. 
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More About Marking 

You can only mark files from one directory tree at a time. For ex­
ample, if you mark files on the hard disk, then move to the tape and 
try to mark files, EzTape will ask you if you want to clear the existing 
marks on the hard disk. 

The Library directory tree allows you to mark files from multiple tapes 
for restoring. This directory tree is useful when you want to mark 
selected files from a split backup set. When you restore from the 
Library, EzTape will prompt you to insert the appropriate tapes as 
they are needed. For more information on using the EzTape Librarian, 
refer to chapter 10. 

Un marking Files and Directories 

To unmark files or directories, highlight the items you wish to unmark 
with your mouse or keyboard. Then, use the Unmark button in the 
command ribbon or the Unmark selected files option in the Mark 
menu to unmark the selected files and/or directories. The black circles 
(or rectangles) by the selected files or directories will disappear. 

If you unmark all files and subdirectories within a directory, a half 
circle (or dot) still appears by the directory to indicate a mark rule has 
been applied. To remove the mark from a directory, you must select 
that directory and use the Unmark selected files option. When you 
unmark a directory, all files and subdirectories in that directory are 
also unmarked. 

Un marking All Files 
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If you want to unmark all the files that are currently marked, select 
the Clear all marks option from the Mark menu. You will receive a 
window asking you to verify. If you select the Yes option, all marks 
will be cleared. If you select No, the marked files will remain marked. 
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Obtaining Information About Marked Files 

Before you backup or restore your marked files, you can: 

• scan the marked files for information 

• list the marked files 

The following sections describe these two options. 

Scanning Marked Files 
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You can scan the currently marked files for the following information: 

• the total number of drives, directories, and files that are marked 
for backup or restore 

• the total number of bytes for all your marked files 

You can use this information to help verify that there is enough room 
on your disk or tape for all the marked files. Scanning marked files 
before a backup or restore activates the time line, bytes and files 
completed, and percentage completed displays in the Status window 
for the operation. 

To scan the marked files, use the Scan button in the command ribbon 
or select the Scan marked files option in the Tasks menu. You will 
see the Scan Marked Files window: 

Scan Marked Files 

Drives: 
Directories: 
Files: 
Total bytes: 

1 

6 
133 
6.304.396 
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~ Note: In multi-tasking systems, the disk contents may 
change between the time you scan a drive and the time the 
backup is completed. Therefore, the scanned and final totals 
may not match exactly. 

Listing Marked Files 

You can access a list of all marked files, including their directory path, 
size, date they were last modified, and attribute flags. You can use 
this information to help verify that you've selected the correct files for 
backup. 

When you select the List marked files option from the Tasks menu, 
EzTape will scan the currently marked files. When EzTape is done 
scanning, you see the Marked File List window: 

C":\PS\SAV"ES\2-2:TIF 
C:\PS\SAVE S\2-3 .TI F 
C:\PS\SAVES\2-4.TIF 
C:\PS\SAVES\2-5.TIF 
C:\PS\SAVES\3-1.TIF 
C:\PS\SAVES\3-2.TIF 
C:\PS\SAVES\4-1.TIF 
C:\PS\SAVES\4-2.TIF 
C:\PS\SAVES\4-3.TIF 
C:\PS\SAVES\5-1.TIF 
C:\PS\SAVES\5-2.TIF 
C:\PS\SAVES\5-3.TIF 

Size Modify date 
37836 OS/20/92 16:33 a --

124430 OS/20/92 16:32 a --
14582 OS/20/92 16:39 a - -
74792 OS/20/92 16:42 a--

124430 OS/20/92 16:47 a - -
48684 OS/20/92 16:48 a--
19616 OS/20/92 16:49 a --
74792 OS/20/92 16:51 a --
47858 OS/20/92 16:53 a --
71398 OS/21/92 09:12 a - -
56882 OS/21/92 09:19 a--
41130 OS/21/92 09:21 a - -
71398 OS/21/92 10:01 a - -

Using the File Management Commands 
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EzTape's File menu offers four commands for managing files on your 
hard disk. Once you have marked files, you can copy, move, delete or 
change their attributes from within EzTape. 
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Copying Marked Files 
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You use the Copy marked files option in the File menu to copy the 
currently marked files to another directory or drive. When you select 
this option, you will see the Copy Files dialog box: 

Copy files 

D [~:~:~:p'J~~:~J D Confirm each file 

[g] Confirm on error 

Enter destination path: 

The table below describes the options you can choose in this dialog box: 

Option: 

Keep tree 

Confirm each 
file 

Confirm on 
error 

Destination 
path 

Choose this option to: 

copy the directory tree structure along with the file. 
For example, if you are copying the file 
C:\EZTAPE\PFILES\BACK.TPF to D:\ and you 
select this option, the file will be copied to 
D:\EZTAPE\PFILES\BACK.TPF. If you do not 
select this option, it will be copied to D:\BACK.TPF. 

receive a request for confirmation for every file you 
are copying. The confirmation will provide options 
for skipping the file, continuing the copy operation, 
and canceling the copy operation. 

receive a message if an error occurs. You will 
have the option to continue the operation or cancel 
the operation. 

determine the directory path where you want to 
copy the files to. 
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Moving Marked Files 

User's Manual 

You use the Move marked files option in the File menu to move the 
files you have marked to another directory or drive. When you select 
this option from the file menu, you see the Move Files dialog box: 

Move files 

D Confirm each file 

[g] Confirm on error D Remove empty directories 

Enter destination path: 

r QK I~ancell 

The table below describes the options you can choose in this dialog box: 

Option: 

Keep tree 

Confirm each 
file 

Confirm on 
error 

Remove empty 
directories 

Destination 
path 

Choose this option to: 

move the directory tree structure along with the file. 
For example, if you are moving the file 
C:\EZTAPE\PFILES\BACK.TPF to 0:\ and you 
select this option, the file will be moved to 
D:\EZTAPE\PFILES\BACK.TPF. If you do not 
select this option, it will be moved to D:\BACK.TPF. 

receive a request for confirmation for every file 
you are moving. The confirmation will provide 
options for skipping the file, continuing the move 
operation, and canceling the move operation. 

receive a message if an error occurs. You will 
have the option to continue the operation or cancel 
the operation. 

remove any marked directories that are empty 
after the move operation. 

determine the directory path where you want to 
move the files to. 
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Note that when you use the Move marked files option and the source 
and target directories are on the same drive, EzTape does not have to 
copy the data - it simply moves the directory entry. 

Deleting Marked Files 
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You use the Delete marked files option in the File menu to delete 
the files you have marked. When you select this option from the file 
menu, you see the Delete Files dialog box: 

Delete files 

DELETE ALL MARKED FILES! 
ARE YOU SURE 

D [~:~:~tf~~:::~:~:~:hJ~:(~] 
[gJ Confirm on error 

D Remove empty directories 

The table below describes the options you can choos-e in this dialog box: 

Option: 

Confirm each 
file 

Confirm on 
error 

Remove empty 
directories 

Choose this option to: 

receive a request for confirmation for every file you 
are deleting. The confirmation will provide options 
for skipping the file, continuing the delete opera 
tion, and canceling the delete operation. 

receive a message if an error occurs. You will 
have the option of continuing or canceling the 
operation. 

remove any marked directories that are empty 
after the delete operation. 
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Changing the Attributes of Marked Files 

User's Manual 

You use the Change marked files option in the File menu to change 
the attributes of the files you have marked. When you select this 
option from the file menu, you see the Change File Attributes dialog 
box: 

Change file attributes 

Select attributes Hidden System 

to apply to @ Ignore @ Ignore 
marked files OOn OOn 

o Confirm each file 
o Off o Off 

[g] Confirm on error Read Only Archive 

@ Ignore @ Ignore 

Ifaneell OOn OOn 

o Off o Off 

The table below describes the options you can choose in this dialog box: 

Option: 

Confirm each 
file 

Confirm on 
error 

Attributes 

Choose this option to: 

receive a request for confirmation for every file you 
are changing. The confirmation will provide 
options for skipping the file, continuing the change 
operation, and canceling the operation. 

receive a message if an error occurs. You will 
have the option of continuing or canceling the 
operation. 

set the hidden, system, read only, and archive 
attributes of the files you marked. If you select On, 
the attribute is turned on for all your marked files. 
Off will set the attribute off and ignore will keep the 
current setting. 
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What This Chapter Contains 

This chapter shows you: 

• what a mark rule is 

• how to use the Apply Rule option 

• how to use the Mark Rules window 

What is a Mark Rule? 

User's Manual 

A mark rule consists of a path specification which represents one or 
more of the files you have marked. Whenever you mark files, a rule or 
rules is created. For example, if you mark the directory TEST in the 
root directory of hard drive C:, the following rule would be created: 

C:\TEST\*.* 

This rule indicates that all files in the directory TEST on C: drive have 
been marked. 

You can view mark rules by selecting Show mark rules from the 
Window menu. 
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Using the Apply Rule Option 

Page 58 

The Apply rules option lets you apply a rule to the directories and 
files you have selected. To use the apply rule option, select the files 
and directories from your Directory Tree window. Then, select the 
Apply rule option from the Mark menu. 

You will see the Apply Rule dialog box: 

Apply Rule 

Mask 1...-1. __________________ -' 

[8] Include subdirectories 

I ~ , &ance, I I Action 

~' ===.:@Mark 

I;Acce~~ J 0 ~Mark 

o Mo!lified only 
Attributes 

[8] Bead only 
[8] ~ystem 
[g] Hidden 

Date/Time------. 

@AlI 
o ftefore 
OQn 
o After 

The following table describes each option in the Apply Rule dialog box 
as well as those in the Edit Rule and Add Rule dialog boxes, which 
are discussed later in this chapter. 
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For this option: Enter: 

Mask 

Include 
subdirectories 

Modified only 

Action 

Attributes 

Daterrime 

User's Manual 

The rule you want to apply. For example, if you want EzTape to mark 
only those files from those you selected that end in the extension ".EXE", 
enter *.EXE in this field. 

In the Add Rule and Edit Rule dialog boxes, you must specify the drive 
or backup set to which the rule will apply. You can use an ampersand (&) 
to indicate that the rule applies to all drives (or backup sets). For 
exa,mple, if you enter a rule &\*.EXE, EzTape will mark all .EXE files on 
all hard drives in your system. 

If you check this box, EzTape will also apply the rule to subdirectories of 
the directories you selected. 

If you check this box, EzTape will apply the rule only to files that have 
been created or modified since last backup. 

In order for the Modified Only option to work effectively, you must select 
the Reset Archive Bits option in the Backup Set Parameter window 
when backing up files (chapter 4). 

Choose whether you want this rule to mark or unmark the files it 
applies to. 

Select the file types you want this applied to. The default is to apply it to 
all files. 

The default for the Apply Rule dialog box is to apply to all files, regardless 
of time and date. If you select a date or time in this option, put it in the 
following format: 

Date: 01-21-91 
Time: 15:53 (equals 3:53 PM) 

When you add a rule using this dialog box, the new rule appears in the 
Mark Rules window. 
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Searching for Files 

You can also use the Apply Rules option to search for files on the 
hard disk, on a tape, or in the tape Librarian. For example, to search 
for all files with an .EXE extension on drive C, you must: 

• select all files on drive C 

• apply the rule *.EXE 

All files with the .EXE extension will be marked. You can select the 
List marked files option from the Tasks menu to view these files in 
the Marked File List window. 

Accessing and Using the Mark Rules Window 
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To access the Mark Rules window, select the Show mark rules 
option in the Window menu. You see the following window: 
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Deleting a Rule 

Chapter 7 

A rule may be preceded by one or more of the symbols in the following 
table. 

Symbol: 

& 

Indicates: 

in place of the drive designator, this symbol means that 
the rule applies to all drives or backup sets 

this rule unmarks files 

this rule has attribute or time/date restrictions. To view 
them, select the Edit button at the bottom of the screen. 

To delete a rule, highlight the rule in the Mark Rules window and 
select the Delete button. The rule will disappear. The files affected 
by the deleted rule will revert back to their former state. For example, 
if you use a rule to unmark a certain file and then delete the rule, the 
file will once again be marked. 

Adding or Editing a Rule 

User's Manual 

To edit a rule, highlight the rule you want to edit and select the Edit 
button. To add a rule, select the Add button. If you select either of 
these buttons, you will see a dialog box asking for rule information: 

Mask Is· WMii\llll 
r8J Include subdirectories 

r E~~:cei~~) ;:::k 
I' Accept 1 0 ~nMark 

Edit Rule 

D Mo!!.ified only 
Attributes 

r8J Bead only 

r8J ,System 
r8J Hidden 

Date/Time --------, 

@AlI 

o Before 
o .Qn 

o After Time 
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Using Mark Rules 

The options in these dialog boxes are the same as those shown for the 
Apply Rule dialog box. The only difference is how you use the Mask 
field. In the Add Rule or Edit Rule dialog box, you must specify the 
drive or backup set to which the rule will apply. 

For example, enter: 

D:\*.DOC 

to apply the rule to all .DOC files on the D drive. 

Enter: 

WEEKLY\*.* 

to apply the rule to all files in the WEEKLY backup set. 
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What This Chapter Contains 

This chapter shows you: 

• what a parameter file is 

• how to create a parameter file 

• how you can use parameter files 

In this chapter, we assume that you are already familiar with how to 
use the Backup Parameters window (chapter 4) and the Restore 
Parameters window (chapter 5). 

What is a Parameter File? 

User's Manual 

A parameter file is a file where you save your file selections so you can 
repeat a specific EzTape task. You can create parameter files for tasks 
that you perform on a regular basis. This allows you to perform these 
tasks without having to configure EzTape each time. 

For example, if you wanted to back up a specific set of files on a regu­
lar basis, you could create a parameter file. This parameter file would 
allow you to perform the backup without having to select the files, 
mark them, and choose backup set parameters each time. 
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How to Create a Parameter File 

EzTape offers two ways to create a parameter file: 

• Use the EzTape menu to create backup and restore parameter 
files only. 

• For advanced users, set up a parameter file using a text editor and 
EzTape's parameter file format. With this method you can set up 
parameter files for any'EzTape task, including backup, restore, 
Short-cuts commands, tape initialization or any other tape utility. 
The parameter file format is described in the "Read Me" file that 
was installed with EzTape. 

Creating Parameter Files from the EzTape Menu 
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The EzTape menu provides options for creating backup and restore 
parameter files. Follow this procedure to create a parameter file: 

1. Mark the files or backup sets that you want to backup or restore. 

2. Select the Save parameter file option in the File menu. If you 
marked files on a hard drive, you see the Backup Parameters 
window. If you marked backup sets on a tape (or the library), you 
see the Restore Parameters window. 

3. Fill in the boxes for the options you want, then select OK. The 
Save parameter file window will appear: 

Directory c:\eztape 

File name 

Save Parameter File 

Directories 

[ .. ] 
[lib] 
[-a-] 
[-b-] 
[-c-] 
-f-

4. Enter a file name, then select OK. EzTape will save your param­
eter file with a . TPF extension. 
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How You Can Use Parameter Files 

EzTape allows you to use parameter files: 

• within EzTape, for backup and restore parameter files only 

• from the command line 

• to perform automatic operations. Refer to chapter 9, Using the 
EzStart Program for information about this procedure. 

Loading a Parameter File in the EzTape Window 

When you load a backup or restore parameter file in the EzTape 
window, EzTape will mark the files as specified. Use the following 
procedure to load a parameter file. 

1. Select the Load parameter file option from the File menu. If 
you currently have files marked, you will be asked if you want to 
clear those marks. If you answer Yes, the marks will be discarded. 
If you answer No, the marks from the parameter file will be added 
to those you have already made. 

You will see the following dialog box: 

Load Parameter File 

Current directory... c:\eztape 

Filename............. '=N=U=. _______________ --' 

[ .. ] 
[lib] 
[-a-] 
[-b-] 
[-c-] 
[-f-] 
[-g-] 
-m-

Directories Files 

+ bc.tpf 
captures.tpf 
shrtbkll.tpf 
shrtchgd.tpf 
shrtrstl.tpf 

I Cancel 

L: Load 

2. Select the directory of the parameter file that you want to load. 
You will see a list of the parameter files in that directory. Select 
the parameter file you want to load. 
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When you select a parameter file, you may receive a message 
asking if you want to clear current marks. This message indicates 
one of the following: 

• you did not clear the current marked files when you were 
prompted earlier in this procedure 

• there are marks on a different device type than those in the 
parameter file 

For example, if your parameter file marks files on a hard drive 
and you currently have files marked on a tape, you must clear the 
marks on the tape or the parameter file can't be loaded. 

When you have selected a parameter file, EzTape will load it. The 
files specified in the parameter file will be marked. You may mark 
additional files or remove marks from your selections. 

3. Select Start a backup or Start a restore from the Tasks menu. 
(These commands are also available on the ribbon.) The Backup 
Parameters or Restore Parameters window will appear, 
depending on which task you selected. This window contains the 
options you chose for the parameter file when you set it up. You 
may change these options or accept them as is. 

4. Select OK to begin the backup or restore. 

Running a Parameter File from the Command Line 
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EzTape allows you to execute a parameter file without entering the 
EzTape menu, through the command line. 

EzTape for DOS Users 

To execute a parameter file: 

Type the following information at the DOS prompt: 

EZTAPE [parameter filename] [Enter] 
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EzTape for Windows Users 

To execute a parameter file: 

1. Select Run from Program Manager's File menu 

2. Enter the following information in the Command line box: 

EZTAPEW [parameter filename] 

3. Select OK. 

In both DOS and Windows, if your path statement does not include 
the EzTape program directory, you must also include the full path 
name of the directory where you installed EzTape. 

EzTape assumes that your parameter files end with .TPF. If you used 
a different extension, make sure to include this extension when you 
type in the filename. 

For example, if you want to run a parameter file named 
BACKUPC.TPF, you would type: 

EZTAPE BACKUPC (DOS) 

or 

EZTAPEW BACKUPC (Windows) 

Adding a Parameter File as a Program Item (Windows Users Only) 
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In you are running Windows, you can set up a parameter file as a 
program item in a group window. For example, you could add a 
parameter file to the EzTape group. That way, you can execute the 
parameter file simply by clicking its icon. 

For more information on adding program items to a group window, 
refer to your operating system documentation. 
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What This Chapter Contains 

This chapter describes the EzStart program and shows you how to use 
the EzStart window to set up EzStart events. 

What is EzStart? 

EzStart is a special program which allows you to schedule events to 
run automatically while you are away from the computer. An event 
might be a parameter file you've created, or a DOS or Windows com­
mand. 

Once you create a schedule of automatic operations, EzStart will 
monitor your system's date and time and perform the events on sched­
ule. Your computer must be turned on with EzStart loaded for the 
program to operate. 

What Happens When an Operation Begins 

User's Manual 

EzStart for DOS 

In the DOS environment, you must be at the DOS prompt for 
EzStart to execute a scheduled event. If your computer system is 
busy at the time an event is scheduled to run, EzStart will beep to let 
you know that it's ready and will postpone the event. EzStart will 
check every 60 seconds after the scheduled time to see if the system is 
free. 

EzStart for Windows 

In Window's multi-tasking environment, EzStart simply begins the 
event when scheduled, even if you are using other applications at the 
time. 
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Installation Notes 

If you selected Add EzStart during the installation process, EzStart 
will load automatically every time you start your system. If you did 
not select this option, follow the procedures below to load EzStart. 

EzStart for DOS 

EzStart for DOS actually consists of two program: 

• EZTIMER is a memory-resident program which monitors your 
system for scheduled events and launches them at the appointed 
time. 

• EZSTART provides the window where you set up events. 

In order for EzStart to work, EZTIMER must be loaded into memory. 
To set this to occur automatically, add the following line to your 
AUTOEXEC.BAT file: 

C:\EZTAPE\EZTIMER -r 

Of you installed EzTape in -some other directory, substitute that 
directory name for EZTAPE in the path.) 

Otherwise, you must type EZTIMER -r at a time before your event 
scheduled to begin for EzStart to run the event. 

You can remove the EzStart timer from memory at any time without 
restarting the computer by typing EZTIMER -u. 

EzStart for Windows 
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In the Windows environment, EzStart is a separate application called 
EZSTARTW. To set EzStart to load automatically, add the following 
line to your WIN.INI file: 

load=c:\eztape\ezstartw 

Of you installed EzTape in some other directory, you should substitute 
that directory name for eztape in the path.) 

EzTape 



Using the EzStart Program 

~ Note: If you have Windows version 3.1 or later, you can 
simply copy the EzStart program item from the EzTape 
group to the Windows Startup group. 

Chapter 9 

You may also load EzStart by using Program Manager's Run com­
mand. Make sure to start the EzStart program before your event is 
scheduled to begin. 

Scheduling Events in the EzStart Window 

Use the EzStart window to set events to run automatically and view 
events you have already scheduled. 

Opening the EzStart Window - DOS 

To open the EzStart for DOS window, type: 

EZSTART [Enter] 

If the EzTape program directory is not in your path, you must include 
the full path name of the directory where EzTape is installed. 

You will see the EzStart window, similar to one for the Windows 
environment, shown below. 

Opening the EzStart Window - Windows 

To view the EzStart window in under Windows, maximize the EzStart 
icon at the bottom of the desktop. You will see the EzStart window: 

II EzStart for Windows a 
Eile .Q.ptions .!:ielp 

Next Scheduled Task: C:\EZfAPE\EZfAPEW.EXE shrtbkll.tpf 

Start Time: Fri May 22. 1992 10:40:10 

CurrentTime: Thu May 21. 1992 10:43:10 

ri Ma 22. 1992 10:40:10 R C: EZfAPE EZfAPEW.EXE shrtbkll.t f 
Tue Jun 30. 1992 12:15:00 0 C:\EZfAPE\EZfAPEW.EXE captures.tpf 
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The EzStart window provides the following information: 

• The upper portion of the screen displays the event that is sched­
uled to occur next. 

• The lower portion of the screen lists the events you've scheduled to 
run. Start dates are listed at the left. You will see the letter "0" 
or "R" to the left of the event. An "0" indicates that the event will 
occur one time only. An "R" indicates that it is set to recur. 

The following sections describe how to use the four option buttons: 
Edit, Add, Delete, and Suspend. 

Adding/Editing an EzStart Event 
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To add an event to the EzStart schedule list, select the Add button. To 
edit an event in the EzStart schedule list, highlight the event you want 
to edit and select the Edit button. 

When you select the Add or Edit button, you see the EzStart Event 
Schedule window: 

Dispatch r------, 
Time 110:43:53 

Date 105/21/92 

D Recurring Event 

D Announce Event 

Arrow for 
Command 
drop-down list 

Arrows for 
Frequency 
Option 
spin button 

Fill in these fields as instructed in the following sections. When you 
are through entering the information into this window, select the OK 
button. You will return to the EzStart window and the event will 
appear in the event list. 

If you do not want this event entered into the EzStart schedule, select 
the Cancel button to return to the EzStart window. 
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Command 

Use the Command field to select the parameter file you wish to 
execute. Open the Command drop-down list box and choose a param­
eter file from the list displayed. 

You can also use the Command field to launch any DOS or Windows 
application. You must include the full path name for the file you wish 
to execute. 

Dispatch Time and Date 

Enter the time, using a 24-hour clock, at which you want the auto­
matic operation to begin. For example, enter 08:00 for 8:00 AM and 
20:00 for 8:00 PM. You can enter times from 00:00 to 23:59. 

Enter the date on which you first want the automatic operation to 
begin. In the U.S., use the format month/day/year; in Europe, use the 
format day/month/year. For example, you would enter the date July 8, 
1993 as 7/8/93 (U.S.) or 8/7/93 (Europe). 

Recurring Event 

Check this option if you want the event to recur over time. When you 
select this option, the Recurring Frequency buttons which were 
grayed out become available at the bottom of the window. Use these 
buttons to indicate how frequently the event should occur. Once you 
make your selection, the entry in the Date box may change to reflect 
your new choice. 

If you select the Weekly button, you must also choose the day or days 
of the week that the event will occur. Use the second row buttons for 
this purpose 

The last button in the top row is a spin button. Use the up and down 
arrows on this button to see additional frequency options. 

One of these options is User defined interval. This option selects a 
recurring interval you specify through the EzStart menu. For more 
information on this option, see Creating a User Defined Interval, 
later in this chapter. 
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Announce Event 

Check this option if you want EzStart to make an announcement 
before launching an event. Under DOS, EzStart beeps to let you know 
an event is due to begin. This gives you the opportunity to exit your 
current application and return to the DOS prompt in time for the event 
to launch successfully. Under Windows, EzStart displays a message 
on the screen announcing when the event will occur. 

When you select this option, the Pre Dispatch Announcement 
buttons will appear at the bottom of the EzStart Event Schedule 
window. Use these buttons to indicate how soon before an event the 
announcement should be made. If you have Ezstart for Windows, you 
can choose a combination of buttons to set announcements to occur at 
different times before the event. 

The EzStart for Windows menu contains an option that allows you to 
choose the type of message EzStart will display. This option is dis­
cussed in Setting a Sticky Announcement, later in this chapter. 

Deleting an EzStart Event 

To delete an event from the EzStart schedule list, highlight the event 
you want to delete and select the Delete button. 

Placing an EzStart Event on Hold 
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From time to time you may have events that you want to remove 
temporarily from the schedule but not delete. EzStart allows you to 
place these events on hold. 

To place an event on hold: 

1. Highlight the event you want to place on hold. 

2. Select the Suspend button at the bottom of the EzStart window. 

The words "ON HOLD" will appear in parenthesis after the event. 
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To take the event off hold: 

1. Highlight the event that is on hold. 

2. Select the Suspend button. 

The words "ON HOLD" will disappear. If the event missed a sched­
uled date, EzStart will give you the opportunity to run the event when 
you take it off hold. 

EzStart's Options Menu 

EzStart's Options menu lets you set a specific repeat interval for a 
recurring event and change the EzStart for Windows announcement 
message. 

Creating a User Defined Interval 
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Select User Interval from the EzStart Options menu to specify your 
own repeat interval for recurring operations. This option sets the 
interval to be used when you select the User defined interval button 
in the EzStart Event Schedule. Once you select this option, you will 
see the User Defined Dispatch Interval window: 

User Defined Dispatch Interval 

Specify the user definable dispatch interval. 

Days [CJ [cancel~ I Hours ~ 
Minutes ~ I:- 0K ~ 

Fill in the fields in this window to indicate the number of days, hours, 
and minutes you want to wait between operation launches. Click on 
the OK button to save your interval settings. 
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Setting a Sticky Announcement (Windows only) 

When EzStart for Windows announces an event, it posts a message 
indicating how long until the event is due to occur. This is called a 
"sticky" announcement because the message stays on the screen until 
the event is dispatched or you choose one of the command buttons in 
the message window. 

The figure below shows an example of a sticky announcement: 

II EzStart dispatch announcement 

~ C:\EZTAPE\EZTAPEW.EXE captures.tpf 

If you don't want the event to occur as scheduled, you have two 
options: 

• Select the Suspend button to place the event on hold. 

• Select the Delay button to postpone the event for two minutes. 

You can disable the sticky announce option by selecting Sticky 
Announce from the Options menu. EzStart will still announce your 
event, but the message will appear for 15 seconds only. 

If You Missed a Scheduled Event 
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If EzStart isn't loaded when an event is scheduled to occur, the event 
will not execute as planned. However, if you load EzStart within five 
minutes of the appointed time for the missed event, EzStart automati­
cally launches the event as scheduled. 

If you have EzStart for Windows, the program gives you the opportu­
nity to run any missed events when you load it the next time. 

After an event has occurred, EzStart changes its status to 
"DISPATCHED" but keeps it in the window in case you want to 
schedule it to run again. 
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What This Chapter Contains 

This chapter shows you how to: 

• create a Library of backup set information 

• use the Librarian to search for and restore files from tape 

• use the Librarian menu options 

What is the Librarian? 

You use the Librarian to store and manage directory information for 
your EzTape backup tapes. With the Librarian, you can form an 
organized tape library so that you can quickly and easily retrieve 
information. 

Every time you update a tape into the library, the Librarian creates a 
directory of backup sets and files contained on that tape. It stores this 
information on your hard disk, in a directory called \LIB. This 
directory is located inside the directory where you installed EzTape, as 
its subdirectory. 

Viewing the Contents of the Library 

To access the Library, you can either: 

• click the Library button in the command ribbon 
• select Library from the Tree menu 
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The list of the backup sets stored in the Library will appear in the 
Directory Tree window: 

The Library's directory tree contains the following items: 

• A list of all of the backup sets with directory information 
recorded in the Library. 

• Each backup set shows the eight character tape ID number of 
the tape on which it is stored. 

• Individual directories that may be expanded or collapsed as 
described in the previous chapters. You may open these directo­
ries to see a list of its subdirectories and files. 

Setting EzTape to Automatically Update the Librarian 
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The Library is only useful as long as you keep it current. You can set 
up EzTape to automatically update the Librarian whenever you make 
a backup file. The information for the backup set you create will be 
added to the Library. 
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When you select Backup Defaults under the Options menu, you see 
the following window: 

r- Compression­

@ None 

o Levell 

o Level 2 

o Hardware 

o Encryption 

Backup Defaults 

[?5] r.R.~·.~:.~f.~i~hEi..~·::.~)!.~] 
Options ••. 

o Verify after backup 

[g] Add to library Cancel 

o Save defaults to disk 
OK 

Select the Add to Library box so that the default is to update the 
library each time you do a backup. When you do a backup, this option 
should be marked in the Backup Parameters window. You may also 
want to include this option when you back up using a parameter file. 

If you do not select the Add to Library box, EzTape will not update 
the library when you make the backup. It is possible for you to use the 
Librarian to update the library at a later time, but it is most conve­
nient to use the auto-update feature so that entries are created in the 
library as backups are performed. 

Label Your Tapes 
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The Librarian will assign a serial number to each tape you use. 

~ Note: Be sure to label your tapes to reflect these numbers. 
That way, you will be able to locate the tapes you need. 

You can check a tape number by using the Display Tape Info option 
under the Utilities menu. 
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Using the Librarian to Search for and Restore Files 

You can use the Library to locate a specific file on tape, then restore it. 
Say, for example, you backed up a file several months ago and have 
since forgotten which tape you recorded it on. If you know the name of 
the file, or some other identifier, you can locate the file and restore it 
without leaving the Library. 

Searching the Library 

To locate a file in the Library: 

1. Click the Library button in the command ribbon or select the 
Library option in the Tree menu to access the Library Directory 
Tree. 

2. Highlight the backup sets that you want searched. 

3. Select the Apply Rule option from the Mark menu. The Apply 
Rule dialog box will appear. 

4. Use the options in the Apply Rule dialog box to set the criteria 
for your search. Refer to chapter 7, Using Mark Rules, for a 
description of the options in this dialog box. 

5. Select OK. EzTape will mark the files that meet the rule you've 
set up. 

You can select the List marked files option from the Tasks menu to 
view these files in the Mark File List window. 

Restoring Files from Tape with the Librarian 
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Once you've located your files, you can restore them right from the 
Library. Simply mark the backup sets or files and start the restore 
just as you would if you were restoring from tape (chapter 5). If you 
used the Apply Rule option to search for your files, they are already 
marked. 

The Librarian allows you to restore files from multiple tapes. You can 
also use the Librarian to restore files from a split tape. When you 
restore from the Library, EzTape will prompt you to insert the correct 
tapes as they are needed. 
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The Librarian Menu 

The Librarian menu includes the following options: 

• Update library 
• Backup sets 
• Remove tapes 

The following sections describe these options. 

Updating the Library 

Backup Sets 

You use the Update library option to add a tape's backup set 
information to the Librarian. If you have already set automatic 
updating for your Librarian (as described earlier in this chapter), the 
library will be updated automatically whenever a backup is performed. 
You need to use this option if: 

• the automatic update option is not set 

• you need to add backup sets that have not been previously added 
to your Library 

Once you select this option, the Librarian will read the directory 
information on the tape and check this against the existing library. If 
there are any differences, EzTape will remove backup sets from the 
library that no longer exist on the tape and then add to the library 
those that were created since the last library update. 

You use the Backup Sets option to call up the Library Backup Set 
List window. You can use this window to: 

• display information about a particular backup set 

• delete backup set information from the library 
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Using the EzTape Tape Librarian 

The following shows an example of the Library Backup Set List 
window: 

II Library 8ackup Set List 

[28685938J Drive C 
[28685938J Drive C-2 
[28685938J Drive C-3 
[28685938J Drive G 
[28685938J Reports 
[28685938J Current projects 

To exit this window, click the Continue button. The following 
sections describe the Info and Delete buttons. 

Displaying Information About a Backup Set 

To display information about a backup set, highlight the backup set 
name in the Library Backup Set List window and select the Info 
button. You will see a Backup set information window similar to the 
one below: 

1:1 8ackup Set Info 

Backup set date: OS/21/92 10:57 Tape ID: 286b593b 

Backup set name: Current projects 
Remarks: Daily backup of current projects. 

Backup set size: 
Compressed size: 
Compression ratio: 
Source drive: 
Type: 
Backup set piece: 

95K 
56K 

1.6 to 1 
C: 

DOS 

Password protected 
Compressed 
Encrypted 
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The Backup Set Info window contains the following information about 
your backup set: 

• backup set name 

• the date and time that the backup set was made 

• the Tape ID number assigned by the Librarian 

• the remarks you entered at the time of the backup 

• the size of the backup 

• the compressed size of the backup (if you don't use compression, 
this size will be the same as the backup set size) 

• the compression ratio (if you didn't use data compression, the ratio 
will be 1.0 to 1) 

• the source drive 

• backup type (DOS, OS/2 FAT, OS/2 HPFS, etc ... ) 

• the backup set piece (if the backup is contained on one tape, this 
number will be 1 and Backup Continued will be grayed out) 

This screen will also tell you if the backup set: 

• is password protected 
• uses data compression 
• is encrypted 

If a feature is grayed out, then the backup set does not use this 
feature. 

Page 83 



Chapter 10 Using the EzTape Tape Librarian 

Deleting a Backup Set from the Library 

To delete a backup set, highlight the backup set name in the Library 
Backup Set List window and select the Delete button. 

Ybu will be receive a dialog box asking, "Are you sure you want to 
delete this selection?" If you are sure you want to delete the backup 
set from the library, select the OK button. Otherwise, select the 
Cancel button. 

Removing a Tape from the Library 
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The Remove Tapes option allows you to remove all of a tape's backup 
set records from the library. When you select this option, you see the 
following window: 

II library Tape List -

265BDCCB 
[286B593B] 

To exit this window, click on the Continue option. 

To remove a tape from the Library, highlight the tape ID you want to 
remove in the Library Tape List window. When you select the 
Remove button, you will see a prompt asking you to verify. If you are 
sure you want to remove the selected tape from the library, select the 
OK button. Otherwise, select the Cancel button. 
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What This Chapter Contains 

This chapter shows you how to use the options in the Utilities menu 
to perform general tape utility functions. 

The Utilities Menu 

The Utilities menu provides you with the following tape options: 

• Display tape info 
• Name tape 
• Set tape to unused 
• Backup sets 
• Retension tape 
• Initialize tape 
• Eject tape 

The following sections describe these options. 

Display Tape Info 

User's Manual 

Select this option to display information about the tape currently 
installed in your tape drive. This option does not display the contents 
of the tape; to see the contents of the tape, use the Directory Tree 
window as described in chapter 6. 
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Name Tape 
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Using the Tape Utilities 

Here is an example of a Display Tape Info window: 

Tape Information 

Tape name: 

Tape number: 

Formatted: 

Tape status: 

Last tape change: 

Number of bad blocks: 

Percent of tape used: 

Backup sets on tape: 

Total: 

Used: 

Available: 

DAILY BACKUPS 

286B593B 

06/20/90 by CERTIFY CERTt.1-1 

Used by EzTape 3.1 

05/21/92 10:58 

8 
27% 

6 

Tape Space 

78.706K 

20.804K 

57.902K 

Data Space 

122.844K 

23.322K 

99.522K 

Near the bottom of the window is a box with two columns labeled Tape 
Space and Data Space. The Tape Space column indicates tape 
capacities without data compression. The Data Space column esti­
mates tape capacities with data compression, based upon your history 
of data compression use. For a new tape, EzTape estimates the tape 
capacities using level 2 data compression. 

~ Note: The entries indicating the space available and used 
are shown in Kbytes; therefore, the total space on a 80 MB 
tape is displayed as approximately 80,000 Kbytes. 

Select this option to assign a volume name to the tape currently 
installed in your tape drive. Once you select this option, you will see 
the Name Tape window: 

Name Tape 

Enter new tape name (max 31 chars): 
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If the tape already has a name, the name will appear highlighted in 
the tape name field. Enter a name of up to 31 characters in length. 

Set Tape to Unused 

Backup Sets 

Select this option if you want to re-use a tape that has already been 
written to. For example, you might have a full tape which contains an 
old backup. If you decide you don't need the old backup and you want 
to re-use the tape to make a new backup, you can set the tape to 
unused and use it again. 

Caution: Before using this option, make sure that the 
tape does not contain information you want to save. 
Once you set a tape to unused, you can no longer access 
data that was stored on the tape. 

If you have a tape that was written using an EzTape version before 
2.0, you must set the tape to unused before you can write to it with the 
current version of EzTape. 

Once you select this option, EzTape will ask you to provide confirma­
tion before proceeding. 

Setting a tape to unused takes just a short while. When the operation 
is complete, the tape is ready for the next backup; you do not need to 
reinitialize the tape. 

This option allows you to: 

• obtain a list of backup sets on the current tape 

• view information for a backup set 

• delete one or more backup sets from the current tape 
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Using the Tape Utilities 

The figure below shows the Backup Set List window: 

II Backup Set List 

Drive C 
Drive C-2 
Drive C-3 
Drive G 
Reports 
Current projects 

Getting Information about a Backup Set 

To get information about a backup set, select the set from the backup 
set list and select the Info button. If the tape has a password, you will 
be prompted for the appropriate password. You then see an informa­
tion window similar to the one below: 

II Backup Set Info 

Backup set date: 05/21/92 10:54 
Backup set name: Reports 
Remarks: 

Backup set size: 
Compressed size: 
Compression ratio: 
Source drive: 
Type: 
Backup set piece: 

630K 
630K 

1.0 to 1 
C: 

DOS 
contifHleo 

Tape ID: 286b593b 

Par;;sword protected 

Compressed 

Fncr'lilled 
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Retension Tape 

Deleting Backup Sets 

To delete one or more backup sets, select the backup sets in the 
Backup Set List window and select the Delete button. You will be 
asked to confirm that you want the backup sets deleted. If you select 
the OK button, EzTape will delete the backup sets from the tape. 

If you're deleting a backup set that spans more than one tape car­
tridge, EzTape will prompt you to insert the next tape. If that tape is 
unavailable, press [Esc] to leave the operation. If you have a partial 
backup set left on a tape, it can be deleted at a later time. 

Caution: We do not recommend that you restore files 
from partially-deleted backup sets. If a file in the 
backup set is split between two tape volumes and one of 
the volumes has been erased, restoring that file will 
destroy the original file. 

Select this option to properly tension a tape if you have not used that 
tape for a long period of time, or if the tape has been exposed to tem­
perature extremes. Once you select this option, the tape will spool 
from one end to the other, pause, and then spool back. It takes just a 
short while. This option is not available for Irwin 9000 Series drives. 

Initializing a Tape 

User's Manual 

The Initialize tape option formats a blank tape so that it can be used 
with Irwin AccuTrak Series drives (except for the AS50). Mter you 
have initialized a tape once, you should never need to initialize that 
tape again (except ifit is bulk-erased). Read the following sections 
before using the initialize option. 

Using Preformatted Tapes 

We recommend that you use preformatted tapes, such as the AccuTrak 
tape you received with your AccuTrak Series tape drive. AccuTrak 
tapes are ready for use right out of the box. They should never require 
any kind of initialization. You can obtain additional AccuTrak 
preformatted tapes from your dealer. 
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Ejecting a Tape 
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~ Note: If, during your first backup with an AccuTrak tape, 
you receive a message indicating that the media is not servo­
written, is not formatted, or is invalid, do not initialize the 
tape. Your problem is most likely an installation problem. 
Refer to appendix B for troubleshooting information. 

Reusing Tapes 

If you want to reuse a tape that you have used previously to make 
backups, do not initialize the tape. Instead, you should set the tape 
to an unused state as described earlier in this chapter. 

Using the Initialization Option 

~ Note: The initialize option will be grayed out if your tape is 
already formatted or if you are using a tape drive other than 
an Irwin AccuTrak Series drive (except for the A850). 

Initializing an unformatted tape ties up your system and will take 
over an hour. If you are running EzTape for Windows, you can switch 
to other programs while initialization takes place. 

Because initialization procedures place precise servo and formatting 
blocks on a fast-moving tape, occasional formatting errors are not 
unusual. In the event of an error during formatting, you must bulk 
erase the tape before attempting to format the tape again. 

When you select the Initialize Tape option from the Utilities menu, 
EzTape will ask you to confirm that you want to initialize the tape. If 
you select the Yes button, EzTape will initialize the tape. 

Once you have confirmed the operation, the only way to stop it is by 
pulling out the tape. This is not a recommended procedure. There­
fore, be sure you want to initialize before selecting this option. 

If your tape drive has a power load mechanism for loading a tape, you 
can use the Eject tape option. If there is no tape in your drive, or if 
your drive doesn't have a power load mechanism (AccuTrak Series 
drives), this option will be grayed out. 
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What This Chapter Contains 

This chapter shows you how to use options in the View, Window and 
File menus to: 

• determine the order that files are listed in a file window 

• determine if the EzTape windows will stack, tile, or cascade 

• refresh the screen 

• close and open EzTape windows 

• hide and show the command ribbon and the status bar 

• print out the contents of a window 

Determining the Order of Files in a File Window 

User's Manual 

If you have an open window containing a list of files, you can use the 
options in the View menu: 

This option: Sorts the files: 

Sort by name alphabetically by name 

Sort by date chronologically by modification date 

Sort by size by size (large to small) 

Sort by type alphabetically by the file's extension type (.xXX) 
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Stacking, Tiling, and Cascading Windows 

Use the first three options in the Window menu to organize your 
window displays. 

If you select this option: Then: 

Stack windows 

Tile windows 

Cascade windows 

The Directory Tree window will fill the left 
half of the main window and the remaining 
windows will be stacked on top of each 
other on the right half of the screen, with 
the active window on top. This is the 
default setting. 

All open windows will be arranged in a 
grid pattern. The windows will be placed 
side-by-side so that they fill the main 
window. The active window will appear in 
the upper left corner of the main window. 

All open windows will be arranged in a 
cascading pattern. The windows will be 
placed so that they overlap diagonally 
across the main window, starting in the 
upper left corner. The active window will 
appear in the lower right. 

Arranging Window Icons 

When you select Arrange icons from the Window menu, EzTape will 
arrange your file window icons evenly across the bottom of the EzTape 
program window. 

Refreshing Your Window Display 
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When you select Refresh from the Window menu, EzTape scans your 
disk drives for any changes made to files or directories since the last 
update. For example, you may have done a restore, copied files, or 
moved files. EzTape will then update the contents of the Directory 
Tree window and any open file windows. 
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Closing All Directory Windows 

When you select Close all directories from the Window menu, 
EzTape will close all file windows that are currently open. 

Automatically Replacing File Windows 

When you select Replace on open from the Window menu, every 
new file window you open will replace the file window that was previ­
ously open. A check appears by this option if it is in effect. To turn it 
off, select the option again and the check will disappear. 

Opening/Closing Windows 

The Window menu provides the Show directory tree and Show 
mark rules options for displaying these windows. 

When you select one of these options, a check appears by the option 
and the window opens. To close the window, select the option again 
and the check will disappear. 

The Directory Tree Window 

The Directory Tree window lets you list select and mark files on your 
hard disk, on a tape in your backup drive, or in the EzTape library. 
For more information on using the Directory Tree window, refer to 
chapter 6. 

The Mark Rules Window 

User's Manual 

The Mark Rules window provides a list of the rules which represent 
your currently marked selections. A rule consists of a path specifica­
tion or mask which identifies the files you have marked. For example, 
if you choose to backup the directory TEST on hard drive C, you would 
see this mark rule displayed: 

C:\TEST\*.* 

The Mark Rules window also allows you to add, edit, or delete mark 
rules. For more information on using the Mark Rules window, refer 
to chapter 7. 
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Hiding and Showing the Command Ribbon 

The command ribbon provides a means for you to perform commonly­
used operations with simple buttons. When you start up EzStart, the 
ribbon will be visible below the menu bar. 

To remove the ribbon, select the Show ribbon option and the ribbon 
will disappear. When you select Show ribbon again, the command 
ribbon will reappear below the menu bar. 

Hiding and Showing the Status Bar 

The status bar provides a readout which displays the current status of 
your tape operation. When you start up EzTape, the status bar will 
appear along the bottom of the EzTape window. 

To remove the status bar, select the Status bar option and the status 
bar will disappear. When you select Status bar again, the bar will 
reappear. 

Using the Open Windows List 
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If a window is open, it will be listed at the bottom of the Window 
menu. The currently active window will have a check by it. If you 
select the name of one of the other open windows, it becomes the active 
window, and the check will appear by that window. 

When you have more than nine windows open, the words More 
Windows ... will appear at the end of the window list. Select this 
option to see a list of all open windows. You may then select one to 
become active. 
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Printing with EzTape 
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The File menu provides options to help you print the contents of an 
EzTape window. 

You use the Print Window option to print the information in the 
currently selected EzTape window. When you select this option, you 
will see the following window: 

Save Window 

~SaveTo----------------~ 

o Disk file 

@ Printer 

If you choose the Printer option, the information will be sent to your 
printer. Make sure that the EzTape Printer Setup dialog box is set 
up and your printer is turned on before using this option. 

If you choose the Disk File option, you will see the following dialog 
box: 

Directory c:\eztape 

File name 

Save Disk File 

Directories 

[ .. ] 
[lib] 
[-a-] 
[-b-] 
[-c-] 
-1-

Choose the directory and file name where you want to log the 
information. 
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Using the Printer Setup Window 
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When you choose the Printer Setup option, you see a window that 
contains your printer's properties. Make sure that these properties are 
set correctly before printing. 

This window is controlled by your printer driver. The properties in 
this window will vary, depending on your printer. For more informa­
tion on setting up this window, refer-to your printer documentation. 

EzTape 



Setting the Default Options 13 
What This Chapter Contains 

This chapter shows you how to use the Options menu to set defaults 
for: 

• EzTape window interactions 

• the Backup Parameters window 

• the Restore Parameters window 

• the dialog boxes for these File menu options: Copy files, Move 
marked files, Delete marked files, or Change marked files 

Setting Window Defaults 

User's Manual 

When you select the Window defaults option, you will see one of the 
following dialog boxes: 

EzTape for DOS 

Window Defaults 

o Dis la sllOrt-cuts on startu 
~ Sl10w ribbon 
~ Show tape status bar 
~ Replace window on open 
:i1in{;i~!£t:H~----------, 
ci> Sort blj file, name 
o Sort blj file' date 
o Sort blj file size 
o Sort blj fi Ie tlJPe 

~ 43 ..... 50. Ii 'rie mode 
~ Use graph ic mode . ,', ., r¥]l[f~', [tnceIfr 
o Sauedefaultsto disk 
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Setting the Default Options 

EzTape for Windows 

Window Defaults 

o r.p·I~p.(~y."".~.6·.Q.ri:~.~!'~·".·.Q·.ri"".~·~.~·.ri·~.·p.J 
rg] Show ribbon 

rg] Show tape status bar 

rg] Replace window on open 

""Sort Mode 

@ Sort by file name 

o Sort by file date 

o Sort by file size 

o Sort by file type 

o Save defaults to disk 

1r~'QK"-~] F~ncel] 

The table on the following page describes each of the default options 
you can set. 
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Option: 

Display short-cuts 
on startup 

Show ribbon 

Show tape status bar 

Replace window on 
open 

Sort mode 

43/50 line 

Graphic mode 

Save defaults to disk 

Chapter 13 

What it does: 

Opens the Short-cuts dialog box when you start EzTape. This menu will 
be the first window you see. Check this box if you use the Short Cut 
options frequently. 

Displays the command ribbon when you start up EzTape. 

Displays the tape status bar when you start up EzTape. 

When you open a new file window, it will replace the previous file window. 

Determines the order of the contents in a file window. You can choose to 
list files alphabetically by name, chronologically (by date), by size (large 
to small), or alphabetically by the files' extension type (.XXX). 

(EzTape for DOS only) Selects a compact screen display. If you have an 
EGA monitor, you will see 43 lines per screen. If you have a VGA 
monitor, you will see 50 lines per screen. This option is not available in 
systems with CGA or monochrome monitors. 

(EzTape for DOS only) Sets the EzTape display so it makes use of 
special graphics characters that improve screen appearance. This option 
is not available for systems with CGA or monochrome monitors. 

Saves the default settings for future sessions If you do not select this 
option, these settings will apply only to the current session and will not be 
saved if you exit EzTape. 

Select the OK button to accept the new defaults or on the Cancel 
button to return to the EzTape window without changing the defaults. 
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Setting Backup Defaults 

When you select the Backup defaults option, you see the following 
window dialog box: 

Compression 

@ None 

o Levell 

o Level 2 

o Hardware 

o Encryption 

Backup Defaults 

[g] r.R.~·.~·.~·(.~·.i~h.b~.~·.·".~·.l·i~l 
o Verify after backup 

[g] Add to library 

o Save defaults to disk 

It" "?Ptio~s: .. : I 
I:'~" Cancel . " 

II w •• ·i~.OK .~.~.J 

If you are not familiar with the backup parameters, refer to chapter 4. 

Choose the Save defaults to disk option to save these default 
settings for future sessions. If you do not select this option, these 
settings will apply only to the current session and will not be saved if 
you exit EzTape. 

When you are through setting backup parameter defaults, select the 
OK button to accept the new defaults or the Cancel button to return 
to the EzTape window without changing the defaults. 

Setting Restore Defaults 
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When you select the Restore defaults option, you see the following 
dialog box: 

Restore Defaults . 

File Overwrite----------------, 

@ i:p:Q:::~:Qi::Qy.:~:~i:!i~:::~:~~:~i::f.!I~:~:i 
o Prompt if newer file exists 
o Restore all selected files 

[g] Restore with directory structure D Save defaults to disk 
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If you are not familiar with the restore parameters, refer to chapter 6. 

You can also choose the Save defaults to disk option to save these 
default settings for future sessions. If you do not select this option, 
these settings will apply only to the current session and will not be 
saved if you exit EzTape. 

When you are through setting restore parameter defaults, select the 
OK button to accept the new defaults or the Cancel button to return 
to the EzTape window without changing the defaults. 

Setting Organize Defaults 
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When you select the Organize defaults option, you see the following 
dialog box: 

Organize Defaults 

D [~:~:~:p'j:~~:~l 
[g] Confirm on error 

D Confirm each file 

D Remove empty directories 

D Save defaults to disk 

These options are defaults for the Copy files, Move marked files, 
Delete marked fil~s, or Change marked files commands in the 
File menu (chapter 6). 

The following table describes each of the default options you can set. 
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Option: 

Keep tree 

Confirm 
on error 

Confirm 
each file 

Remove empty 
directories 

Save defaults 

Setting the Default Options 

What it does: 

Copies the directory tree structure along with the file. 

When an error occurs during operation, you are 
notified of the error and given the option to cancel or 
continue. 

You will receive a request for confirmation of every 
file. You will have the option to skip the file, cancel, 
or continue. 

Deletes any marked directories that are empty after 
the operation is complete. 

Saves these default settings for future sessions. If 
you do not select this option, these default will apply 
only to the current session and will not be saved if 
you exit EzTape. 

Select the OK button to accept the new defaults or on the Cancel 
button to return to the EzTape window without changing the defaults. 
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What This Appendix Contains 

This appendix provides the information you need to use EzTape on a 
network. You can use EzTape with most popular network operating 
systems, including Novell NetWare®, NetWare Lite, LANtastic®, 
lONET®, IBM PC LAN® and NetBIOS compatible networks. 

Before you read this appendix, you should read chapters 2, 4, 5, and 6. 
These chapters present concepts about the EzTape menu system and 
file selection that you should be familiar with before proceeding. 

General Network Guidelines 

This section provides information which applies to all networks that 
EzTape is compatible with. Later sections in this appendix provide 
information about specific networks. 

To run EzTape on a network, follow these guidelines: 

1. Install your tape drive and EzTape on a workstation, not on the 
server. 

2. Use normal file selection processes. 

3. If your network uses trustee or access rights, you must have the 
rights to access those files you intend to backup or restore. 

4. If a file is open during backup or restore, EzTape will skip the 
open file. You can set the backup parameters so that EzTape will 
inform you when a file is skipped (chapter 4). We recommend that 
you have users log out during system backup to minimize the 
occurrence of open files. 

5. Note that EzTape will back up special network security files. 
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Selecting Files for Backup or Restore 
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When using EzTape on a network, you may see a number of different 
drive letters listed. Of these drive letters: 

• one or more will be your local hard disk(s) 

• the others may have the same volume name; in actuality, these 
are different areas of the network server that you are "mapped" to 

You can select files to backup from or restore to any drive that is 
displayed. 

Caution: When performing a restore, pay attention to 
the directory path in the restore parameters window. 
The default value is the path of the drive from which 
the backup set was made. Be sure to change it if 
necessary. Otherwise, you could restore data to an 
incorrect drive. 

Use normal file selection techniques to include or exclude specific files, 
as described in chapter 6. EzTape will then back up or restore the 
files you marked for selection unless either: 

• you do not have access rights to a selected file 

• the file is in use on the network 

In either case, EzTape skips the ineligible files and displays a message. 

When the operation is complete, all files chosen will be backed up or 
restored. Note that backing up multiple and/or large network drives 
could take more than one tape. 
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Network-Specific Information 

The following sections provide specific information about EzTape­
compatible networks. 

NetB/OS and DOS Peer-to-Peer Networks 

User's Manual 

EzTape provides complete support for NetBIOS and DOS peer-to-peer 
network operating systems. If you are using one of these networks, 
such as NetWare Lite, LANtastic, lONET or IBM PC LAN, you can 
back up and restore your entire network from a workstation running 
EzTape. 

What You Need 

In addition to the EzTape system requirements listed in the EzTape 
Getting Started Manual, you need: 

• a network workstation with a tape drive installed 

• enough available memory to run EzTape after loading the network 
operating system 

• access rights to the DOS servers or workstations you wish to back 
up. For example, in a LANtastic environment, you must be logged 
into each server you wish to back up. You must then assign a 
unique logical drive designation for each server. 

EzTape will display each available server or workstation in the 
Directory Tree window. Follow the procedures in chapter 4, Backing 
Up Data from Disk to back them up. 
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Novell NetWare Networks 
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EzTape provides complete support for networks running under Novell 
Advanced NetWare software. In addition to being able to back up and 
restore user files on the network, EzTape can handle special network 
system files and security information. 

What You Need 

In addition to the EzTape system requirements listed in the EzTape 
Getting Started Manual, you need Novell Advanced NetWare v2.0a 
or later. You must install the tape drive at a workstation. 

NetWare Work Files 

When you run EzTape, three NetWare files will appear as open files 
not eligible for backup: DIRSTAMP.SYS, ISYS:INET$MSG.SYS, and I 
SYS:INET$SPL.QUE. These files cannot and need not be included in 
the backup; they are NetWare work files. 

Bindery Files 

Bindery files are special NetWare files which contain network user 
information, such as user names, ID numbers, and passwords. Bind­
ery files are not normally available to network users. 

When you run EzTape on a NetWare network, it automatically checks 
to see if you are logged in as the Supervisor. If you are, EzTape 
enables access to the bindery files; otherwise, it does not. 

NetWare version 2.x bindery information is contained in two files, 
called NET$BIND.SYS and NET$BVAL.SYS. NetWare version 3.x 
bindery information is contained in three files, called NET$BIND.OBJ, 
NET$PROP, and NET$VAL. If you select one of these files for backup 
or restore, the other associated fileCs) will be included in the operation. 
This ensures that you do not accidentally back up or restore only one of 
a set of bindery files, which could possibly destroy their validity. 
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Option: 

o 

1 

User's Manual 

Trustee Rights 

Whenever you use EzTape to back up files from a NetWare network 
drive, it automatically saves the trustee rights. The trustee rights are 
assigned at the directory level and specify which network users have 
access to particular files. 

When you perform a restore in the NetWare network environment, you 
have several options with regard to the trustee rights. You will be 
prompted to select an option during the restore procedure as part of 
the restore parameters display. The following table describes these 
options: 

Description: 

Do not restore any of the trustee information. If you are restoring files to an 
existing directory for which the correct trustee rights have already been 
established, choose this option. Similarly, if you are restoring files to a directory 
for which no trustee rights are desired, choose this option. 

For example, if you are transferring one of your work files from one Novell network 
to another Novell network, you might choose option o. The trustee rights already 
established on each of the networks would remain the same. 

If you select option 0 when restoring to a different target, the trustee rights will not 
be affected since you will not be restoring any trustee information. 

Restore trustee information for the directory containing files that have been 
selected for restore. If you select option 1 when restoring to a different target 
and you elect to keep the tree structure, EzTape will recreate the tree under the 
target directory and restore the trustee rights for the directory containing the files 
being restored. 

If you select option 1 when restoring to a different target and you elect not to keep 
the tree structure, EzTape will restore the trustee rights for the directory containing 
the files being restored to the new target directory. 
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Using EzTape on a Network 

Description: 

Restore all trustee information. This type of restore includes the trustee rights 
as in option 1, but also includes rights associated with directories that are parents 
to the directory receiving the restored files, up to the root directory. You must have 
parental rights to the directories being restored. 

If you select option 2 when restoring to a different target and elect to keep the tree 
structure, EzTape will recreate the tree under the new target directory and restore 
the trustee rights at each level on the tree. 

If you select option 2 when restoring to a different target and elect not to keep the 
tree structure, EzTape will assign the trustee rights for the files being restored to 
the target directory. All of the rights up the original path will be assigned to the 
target directory. 

The figure below shows an example of restoring trustee rights using 
Option 1. FILEB and its trustee rights are shown after being restored 
to the new directory DlRA, both with and without its tree structure. 

New target, keeping tree structure. 

New target, without tree structure. 
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The following figure shows an example of restoring trustee rights using 
Option 2. FILEB, its trustee rights, and associated rights are shown' 
after being restored to the new directory DlRA, both with and without 
its tree structure. 

New target, keeping tree structure. 

New target, without tree structure. 

Maximum Rights 

Maximum rights allow an owner of a directory to set the maximum 
rights anyone else on the network can have to that particular direc­
tory. EzTape saves the maximum rights value during backup and 
restores it when trustee rights are included in the restore. They follow 
the same rules under the options for trustee rights. 
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What This Appendix Contains 

This appendix shows you what you should do if you experience 
difficulties while using EzTape. 

If you encounter a problem, first read the information below and check 
the error messages at the end of this appendix. There may be a simple 
solution to your problem. 

If you still need help, call us at one of the numbers listed at the front of 
the manual. Make sure you have your tape drive model number and 
serial number available. Also, write down any error messages that 
occurred to help your technical support representative identify and 
correct the problem. 

Difficulties Recognizing a Preformatted Tape 

User's Manual 

If, during your first backup with a preformatted tape, you receive a 
message indicating that your tape is not servo-written, is not format­
ted, or is invalid, do not initialize the tape. Your problem is most 
likely one of the following: 

1. Make sure you are using the correct type of tape cartridge for your 
drive. 

2. If everything seems to be set correctly, remove and reinsert the 
tape. It may not have been fully seated. 

3. If you are using an external drive, move it away from the monitor 
or from other devices that give off electromagnetic interference. 

4. Turn off your computer completely and then restart. In rare cases, 
a "stuck bit" may be the problem. 
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5. If you are using an internal drive, make sure it is installed prop­
erly, and all switches and jumpers are properly set. Make sure any 
additional installation hardware is also properly installed and set. 

Difficulties Reading or Writing a Tape File 

If you experience difficulties while reading from a tape cartridge 
(restore) or writing to a tape (backup), follow these steps: 

1. Try the operation again. The problem may be temporary; for 
example, a speck of dust or other contaminant may have inter­
fered with the drive reading the tape. 

2. If you are using an external drive, move it away from the monitor 
or from other devices that give off electromagnetic interference. 

3. If the problem persists and occurs during backup, use the Reten­
sion Tape option under the Option menu to align the tape. If 
that does not help, use a different tape. If there is no problem 
with the new tape, you should discontinue use of the old tape. 

4. Clean the tape drive's read/write head and capstan, then try the 
operation again. Refer to your tape drive's installation manual for 
cleaning information. 

5. Turn off your computer completely and then restart. In rare cases, 
a "stuck bit" may be the problem. 

If the problem persists, call your tape drive dealer for assistance. 

Difficulties Initializing an Unformatted Tape 
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If you are using an Irwin AccuTrak Series drive (except for the A850) 
and your tape is unformatted, it must be bulk erased before initializa­
tion. You can bulk erase a tape using the Irwin TCE 200, or with an 
audio/video bulk eraser that you can purchase at most electronic 
stores. -We recommend that you erase both sides of the tape. 
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Difficulties Reading or Writing a Disk File 

If EzTape is unable to read or write a file on your computer's hard 
disk, check the following: 

1. Does the file name, as you typed it, exist in the current or specified 
directory, on the current or specified disk drive? 

2. Is the disk full? If so, remove or delete some files and try again. 

3. Are you using the root directory? It may be full. The number of 
files the root directory can accommodate is limited. Refer to your 
DOS manual for more information on this limitation. Remove a 
few files from the root directory and try again. 

4. Are you trying to write to a file that is flagged as read-only? 

If a Power Failure Occurs 

If electrical power is interrupted during a backup or restore operation, 
simply start over when the power returns. Incomplete data written by 
the interrupted operation will be replaced by the new operation. 

If Your Tape Drive Fails 
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If your tape drive has problems or fails during operation, refer to your 
tape drive's installation manual for troubleshooting information. If the 
problem persists, call your tape drive dealer for assistance. 
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Interpreting Error Messages 

When EzTape has trouble executing an operation, it displays an error 
message to help you diagnose and correct the problem. If you encoun­
ter an error message, check the following list to see if there is a solu­
tion you can try. If you cannot correct the problem, make a note of the 
information so that you can discuss the problem with your technical 
support representative. 

General Error Messages 

This section describes errors you may encounter when performing 
backup, restore and utilities operations. 

Error Message: 

Data was read, using ECC 
Data was read, using retries 
Defect spares are all used 
10 CRC or ECC error 
10 was read, using ECC 
Medium positioning error 
Missing data or data addr mark 
Missing 10 or 10 address mark 
Record not found 
Track following error 

Could not create directory 
[directoryname]. No files 
in it will be restored 

Could not create target 
path 

Could not open file 
[filename] - file not 
backed up 
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Description: 

The tape media in the cartridge is degrading. You should replace 
the tape cartridge. 

An error has occurred during a restore operation while creating a 
directory on the hard disk. There may be an existing file with the 
same name, or the hard disk might be full. EzTape will skip all of 
the files in the directory, but will continue the restore. 

" An error has occurred creating the specified path. There may be 
an existing file with the same name as the target directory, or the 
disk may be full. EzTape will cancel the restore operation. 

The user performing the backup does not have access to the files 
in the directory as determined by the network rights assigned to it. 
It is also possible that the file is unavailable for backup because it 
is in use on the network. A rare possibility when neither of these 
situations applies is a hard failure on the source disk. In all cases, 
EzTape skips the file and continues the backup. 
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Error Message: 

Disk is full 

Disk mount error 

Disk read failure for file 
[filename] - file not 
backed up 

DMA overrun 
DMA underrun 

Drive not ready 

Drive select failure 

Error opening file 
[filename] 

Error writing tape header 

File contents compare 
error 

File [filename] has 
changed - file not 
verified 
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Description: 

There is no more available space on the hard disk. EzTape will 
cancel the restore. 

There is not enough memory to perform the operation. EzTape for 
DOS requires at least 512 KB of available RAM to run. EzTape for 
Windows requires a minimum of 2 MB of installed RAM to run. If 
there is not enough memory available, EzTape will cancel the 
attempted procedure. 

An error has occurred while reading from the hard disk. EzTape 
will skip the file, but will continue the backup. 

There is a problem with your hardware installation. 

The tape was removed while tape operations were in progress, or 
there is a problem with the tape. Try the process again. You 
might also try a different tape. 

There is a problem with your hardware installation. 

An error occurred when opening a file on the hard disk during a 
restore procedure. EzTape will skip the file, but will continue the 
restore. Try the operation again. 

You see this message when a backup fails or the process of 
setting a tape to unused status fails. This message could be 
caused by a variety of problems. Try the process again. You 
might also try a different tape. 

When performing an optional verify pass, there is a comparison 
error between the contents of the tape and the hard disk files. 
EzTape will automatically back up this file again. 

On a multi-user system, it is possible for a file to change between 
the time it is backed up and the time it is verified. If the time, date, 
or size of the tape and hard disk versions of a file do not match, 
EzTape will not attempt to verify the file. 
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Error Message: 

File [filename] will be 
re-copied 

File [filename] will 
not be backed up 

File [filename] will 
NOT be re-copied 

Format failure 

Incompatible 
cartridge/medium 

Medium was changed 

No index pulses 
(NOT SERVOED) 

No track 0 found 
(NOT FORMATTED) 

Seek failure for file 
[filename] - file not 
backed up 

Sharing violation 

Tape is not formatted 
Tape is not servoed 

Tape is write protected 
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Description: 

An error has occurred during the (optional) verification process. 
There may be an error reading from the tape or there may be an 
error in the file comparison. EzTape will back up the file again in 
an attempt to fix the problem. 

An error occurred while reading from the hard disk. EzTape will 
skip the file and continue the backup. 

An error has occurred while reading from the hard disk during the 
(optional) verification process. EzTape will not back up the file 
again, nor will it write over the existing backup set since this may 
be the only data available. 

Initialization has failed. Bulk erase the tape and try again. 

The tape drive does not support the type of tape cartridge inserted. 
Confirm that you are using the correct type of tape for your drive. 

The tape was changed during an operation. Re-install the original 
tape. 

If you are using an AccuTrak tape, check your installation. If you 
are not using an AccuTrak tape, the tape has not been initialized. 
Initialize lhe tape using the Initialize option on the Utilities menu. 

The tape is not formatted. Initialize the tape using the Initialize 
option on the Utilities menu. 

An error occurred while reading from the hard disk. EzTape will 
skip the file, but will continue the backup. 

EzTape attempted to back up a file which was in use by another 
program. The file will be skipped. 

Initialize the tape using the Initialize option on the Utilities menu. 

Remove the tape cartridge and locate its RECORD tab. This is the 
write protect switch. Push the tab to the left, in the direction of the 
arrow. Now you can write to the tape. 
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Error Message: 

Tapes are not being 
restored in order; split 
file [filename] will not be 
restored 

The tape cannot be 
changed while restoring 

There is no tape drive 
present 

This tape is too full 
to begin a backup 

This tape has been 
written by [application name] 

This tape was not 
written with EzTape 

Verify failure for file 
[filename] 

Verify has failed. 
Backup set 
[backupsetname] will 
be deleted. 

Volume not written 
with EzTape 
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Description: 

You will see this message when tapes from a multi-volume 
backup are being restored out of order and EzTape encounters a 
file that spans two tapes. EzTape restore the split file, but will 
restore all other selected files. 

After you enter restore selection, EzTape does not allow you to 
change the tape. To make selections from a different tape, exit 
restore selection, change the tape, then re-enter restore selection. 

Check to make sure that your tape drive is properly installed and 
that all cables are securely connected. It is also possible for this 
message to occur if a tape cartridge is inserted while bringing up 
EzTape. If this happens, exit EzTape and bring it up again. Make 
sure that you insert the tape cartridge either before or after, but not 
during, the loading of the program. 

The tape is already full (or nearly full). Set the tape to unused, 
delete backup sets, or use a different tape. 

The tape was used by software other than Irwin EzTape. 

EzTape can only restore tapes written by EzTape version 2.0 and 
later. 

An error has occurred during the (optional) verification process. 
There may be an error reading from the tape or hard disk, or there 
may be an error in the file comparison. EzTape will back up the 
file again in an attempt to fix the problem, unless the error 
occurred while reading from the hard disk. In this case, EzTape 
will not back up the file again, nor will it write over the existing 
backup set since this may be the only data available. 

You will see this message when there have been verify errors 
which were not corrected by performing the backup a second time. 
EzTape will delete the backup set to avoid the possibility of 
restoring bad data. You should replace the tape. 

You will see this message when attempting to restore a tape which 
was not written by EzTape. EzTape will cancel the restore. 
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NetWare Specific Error Messages 

This section describes errors you may encounter when running EzTape 
on a Novell Net Ware network. 

Error Message: 

Bindery files may be 
restored only to Novell 
drives; the bindery files 
will not be restored 

Could not close 
Novell bindery 

Could not find [filename] 

Could not find owner 
for directory 

Could not get Novell 
base for drive 
[driveletter] 

Couldn't find trustee file 

Error adding trustee 
[trusteename] 

Error writing trustee file 
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Description: 

You have made an attempt to restore NetWare bindery files to a 
drive that is not a NetWare network drive. EzTape will skip the 
bindery files, but will continue to restore operation. 

An error has occurred in the NetWare function call to close the 
bindery files. The files must be closed before EzTape can open 
and read them for backup. There is a problem with the network. 
EzTape will skip the bindery files and continue with the backup. 

EzTape cannot locate one of the NetWare bindery files in the 
\SYSTEM directory. There is a problem with the network. EzTape 
will skip the bindery files and continue with the backup. 

EzTape received an error when asking the NetWare network shell 
for the owner of a directory. EzTape will continue the backup, but 
no trustee information will be recorded for the directory. 

A network error occurred when attempting to restore trustee 
information for a NetWare directory. EzTape will not restore the 
trustee information for the directory, but will continue the restore. 

EzTape cannot read the NetWare network trustee information from 
a tape written by earlier versions of EzTape. EzTape will continue 
the restore operation, but no trustee information will be restored. 
Try the operation again. If it fails a second time, attempt the 
restore using the earlier version of EzTape. 

A network error occurred while attempting to add a trustee for a 
directory which is being restored. EzTape will attempt to restore 
the other trustees for the directory and will continue the restore. 

A tape error occurred while backing up trustee information for a 
directory on a NetWare network drive. EzTape will cancel the 
backup. 
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Error Message: 

Tape read error for 
trustee file 
Tape seek error for 
trustee file 

The bindery files will 
not be backed up 

The bindery may be 
restored by the 
SUPERVISOR only 
and to the SYSTEM 
directory only 

Too many trustees 
in directory 

User [username] 
does not exist on this net 
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Description: 

A tape error occurred for the file containing the trustee information 
for a NetWare directory. EzTape will cancel the restore. 
Retension the tape and then try the operation again. 

EzTape cannot locate (or close) the NetWare bindery files in the 
\SYSTEM directory. There is a problem with the network. EzTape 
will skip the bindery files and continue with the backup. 

You will see this message when attempting to restore the bindery 
files to a NetWare directory other than the \SYSTEM directory. It 
also occurs if a user without supervisor rights attempts to restore 
the bindery files. EzTape will not restore the bindery files, but will 
continue the restore operation. 

A directory on a NetWare drive has more trustee information than 
a buffer can hold. EzTape will continue the backup, but will not 
record the extra trustee information. 

During restore, one of the trustees for a directory on the tape does 
not exist on the target NetWare drive. All other trustees are 
restored, and the restore operation continues. 
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A Backup set (cont.) 

overwrite 29 

About ... 18 password 29 

Active window 17 Backup Set Parameters 

Adding a Mark Rule 61 window 28 

Adding an EzStart event 72 Bindery files - NetWare 106 

Adding backup sets to the 
library 30, 78, 81 C 
Announce event 74 
Apply Rule window 58 Cascade windows 92 
Archive bit 29,55,59 Changing marked files 55 
Arrange icons 92 Check boxes 13 
Attributes Clear all marks 49 

apply rule by 59 Closing windows 9 
changing 55 Collapsing the tree 46 

Automatic start 69 Command buttons 
dialog box 14 

B help topic 20 
Command field - EzStart 73 

Backup Command ribbon 8 

defaults 100 Commands help 18 

features 1 Compression 2, 30 

plan 3 Control menu icon 9 

starting 28 Copying marked files 52 

status 34 Cross-references 20 

Backup all files 25 
Backup modified files 25 D 
Backup Options window 31 
Backup set Data compression 2, 30 

deleting from library 84 Date 
deleting from tape 89 apply rule by 59 
information 82, 88 dispatch 73 
list 82, 88 Defaults 97 
name 28 Definitions 20 
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Delete 
backup sets 84, 89 
EzStart event 74 
Mark Rule 61 
marked files 54 
tapes from library 84 

Dialog boxes 12 
Directory structure - restoring 
with 36 
Directory Tree window 14,44,93 
Disk icon 45 
Dispatch time and date 73 
"Dispatched" 76 
Display tape information 85 
Drop down list boxes 14 

Editing a Mark Rule 61 
Editing an EzStart event 72 
Eject tape 90 
Encryption 30 
Errors - wait for 31,38 
Error messages 

general 114 
NetWare 118 

Excluded files 48 
Expanding the tree 46 
Event 

adding/editing 72 
announce 74 
defined 69 
deleting 74 
recurring 73 
schedule 71 
suspending 74 

EzStart 
defined 69 
for DOS 69, 70, 71, 76 
for Windows 69, 70, 71, 76 

F 

G 

H 

EzStart (cont.) 

loading 70 

EzTape 

opening main window 71 
Options menu 75 

EzTape 
defaults 97 
exiting 21 
for DOS 5, 6, 7, 19, 63, 98 
for Windows 5, 6, 7, 19,62, 97 
overview 1 
main window 8 
menus 10 
starting 7 

Exiting EzTape 21 

File management commands 51 
File menu 21, 24, 51, 64, 65, 95 
File selection 14, 44 
File sorting 91 
File type attributes 55, 59, 91 
File overwrite 37 
File window 14, 47 

Graphics mode 6 
Getting Started manual 5 

Help 
F1 key 18 
for DOS 19 
for Windows 19 
menu 18 

Hidden files 55, 58 
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I Marking files and directories 
manually 44 

IBM PC LAN 105 using apply rule option 57 

ID number - tape 79, 83, 86, 88 Mask 59 

Index - help 18 Maximize button 10 

Initialize tape 89 Maximum rights - NetWare 109 
Menu bar 8 

K Menus 
cancelling 11 

Keep tree 36 choosing menu options 11 

Keyboard help 18 Control Menu 9 

Keys selecting 10 

file selection 16 underlined letter in 10 

shortcut 11 Message logging 34, 40 

L Minimize button 10 
Modified files backup 25 

LANtastic 105 More Windows ... 94 

Librarian Moving among windows 17 

adding to 30, 79 Moving marked files 53 

defined 77 
menu 81 N 

removing tapes from 84 
restoring from 80 Name tape 86 

searching 80 NETbios networks 105 

updating 78, 81 NetWare 

viewing backup set info 81 bindery files 106 

Library icon 45 error messages 118 

List boxes 13 maximum rights 109 

Listing marked files 51 trustee rights 107 

Listing tapes in the library 84 work files 106 

Load parameter file 65 NetWare Lite 105 

Logging messages 34, 40 Network rights restore level 38 
Networks 103 

M 
0 

Mark menu 47, 49, 58 
Mark Rules window 60 "On Hold" 74 

Mark symbols 47 Opening windows 15 
Option button 13 
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Options window Restore (cont.) 

backup 31 starting 36 
restore 38 status 41 

Options menu 97 using librarian to 80· 
Organize defaults 101 Restore all files 26 
Overview - EzTape 1 Restore Options window 38 
Overwrite backup set 29 Restore Parameters window 36 
Overwrite older files 37 Restore to 36 

Restore with directory 
p structure 36 

Retension tape 89 

Parameter files Reusing tapes 90 

adding as program item 67 Rule 

creating 64 adding/editing 61 

defined 63 applying 58 

file format 64 defined 57 

loading 65 deleting 61 

running at command line 66 Running EzTape 7 

saving 64 
Password - backup set 29 S 
Power failure 113 
Preformatted tape 89, 111 Scan marked files 33, 40, 50 
Print window 94 Scheduling an event 71 
Printer setup 95 Scroll bars 10 
Procedures help 18 Searching for files 60,80 

Selecting 

R files and directories 16, 47 
media type 45 

Related topics 20 Set tape to unused 33,87 

Read-only files 55, 58 Shortcut keys 11 

Recurring event 73 Short-Cuts menu 24 

Refreshing your display 92 Show 

Remarks - backup 28 directory tree 44,93 

Removing tapes from library 84 mark rules 57, 93 

Replace on open 93 ribbon 94 

Reset archive bits 29 status bar 94 

Restore Sort by 91 

defaults 100 Split backup set 25, 26, 32, 39, 41 

features 1 Stack windows 92 
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Start backup 28 
Start restore 36 
Starting EzTape 7 
Status bar 9 
Status 

backup 34 
restore 41 

"Sticky" Announcement 76 
Subdirectories 59 
Suspending an event 74 
System files 55, 58 

Tape 
display info 85 
erasing 87 
icon 45 
ID number 79,83,86,88 
initializing 89, 112 
librarian 77 
name 86 
utilities 85 

Tasks menu 28, 36, 50, 51 
Text boxes 13 
Text mode 6 
Tile windows 92 
Time 

apply rule by 59 
dispatch 73 

Title bar 8 
Tree menu 10, 12, 45, 46 
Troubleshooting 111 
Trustee rights - NetWare 107 

Unformatted tapes 90, 112 
Unmarking files 49 

v 

w 

Update library 81 
User defined interval 73, 75 
U sing Help command 18 
Utilities menu 85 

Verify after backup 29 
View menu 91 
Volume name 86 

Wait for errors 31, 38 
Windows border 10 
Window defaults 97 
Window menu 91 

Index 

Misc. 

10NET 105 
43/50 line mode 99 
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